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For customers in North and South America

For customers in Europe

Trademarks
• IBM is a registered trademark of International Business Machines Corporation.
• Microsoft and Windows are registered trademarks of Microsoft Corporation.
• Macintosh is a trademark of Apple Computer Inc.
• All other company and product names are registered trademarks and/or 

trademarks of their respective owners.
• The standards for camera file systems referred to in this manual are the “Design 

Rule for Camera File System/DCF” standards stipulated by the Japan Electronics 
and Information Technology Industries Association (JEITA).

“CE” mark indicates that this product complies with the European 
requirements for safety, health, environment and customer protection. 
“CE” mark cameras are intended for sales in Europe.

For customers in USA
Declaration of Conformity
Model Number : D-580ZOOM/C-460ZOOM/X-400
Trade Name : OLYMPUS
Responsible Party : Olympus America Inc.
Address : 2 Corporate Center Drive, Melville, New York 

11747-3157 U.S.A.
Telephone Number :1-631-844-5000

Tested To Comply With FCC Standards
FOR HOME OR OFFICE USE

This device complies with Part 15 of the FCC rules. Operation is subject to 
the following two conditions:
(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including 

interference that may cause undesired operation.

For customers in Canada
This Class B digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.
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1 Getting started
Names of parts

Camera

Lens barrier
Turns the camera on 
and off in the shooting 
mode. 

Shutter button
  P.45 Flash  P.60

Self-timer lamp  P.66

Connector cover  P.91

DC-IN jack
  P.18

USB connector 
 P.129

Lens
Extends automatically 
when you open the lens 
barrier. 

Zoom lever
 (W/T• )

P.57, P.86, 
P.88

Card cover  P.21

A/V OUT jack 
(MONO)
  P.91

Strap eyelet
 P.15

DC-IN jack cover  P.18

Card slot
  P.21

Microphone
 P.81, P.83, P.94
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Orange lamp  P.46

Green lamp  P.46

AF target mark  P.46

Playback button ( ) 
(QUICK VIEW)

 P.84, P.85
Turns the camera on 
and off in the 
playback mode. 
Switches to the 
playback mode in the 
shooting mode.

Self-timer button ( )  P.66 

Monitor
 P.11

Macro button ( )  P.63

Viewfinder
 P.46

Tripod socket

Flash mode button ( ) 
 P.60

Arrow pad
 ( )

 P.27, P.32

Viewfinder

Arrow pad

OK/Menu button ( )
 P.32

Battery compartment 
cover  P.16

Buttons on the arrow pad have their respective functions. They 
are also used as direction buttons. , ,  and indicate 
which button to be pressed. 

Shooting mode button 
(  : Virtual Dial) 

 P.41
10



Names of parts
1

G
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Monitor indications

Shooting mode

Items Indications Ref. Page

1 Shooting mode , , , , , , P.41

2 Battery check , P.13

3 Green lamp P.44

4 Flash standby
Camera movement warning/ Flash charge

 (lit)

 (Blinks)
P.44

5 Macro mode , P.63

6 Flash mode , , P.60

7 Sequential shooting , P.68

8 Self-timer P.66

9 Record mode SHQ, HQ, SQ1, SQ2 P.73

10 Sound record P.81, P.83, 
P.94

11 Resolution 2288×1712, 1600×1200, 640×480, 
etc.

P.73

12 Metering P.67

13 Exposure compensation -2.0, -1.5, -1.0, -0.5, +0.5, +1.0, +1.5, +2.0 P.77

14 White balance , , , P.79

15 AF target mark [  ] P.44

16 Memory gauge , , , P.13

17 Number of storable still pictures
Remaining recording time

15
00:36

P.44
P.55

2
1 12

14 5

13

14

13

17

5

7

9 16
15

1

Still picture Movie

2
3 4

6

11

98

6

8

12

17

15

10 10
11
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Names of parts

G
etting started
Playback mode
INFO setting allows you to select how much information to display on the 
monitor. Screens when the Information display is set to ON are shown below. 

"Displaying shooting information" (P.109)

• The indications that appear on a movie picture that has been selected 
and displayed from the index display are different from those that appear 
when the movie picture is displayed using the movie playback function. 

Items Indications Ref. Page

1 Print reservation,
Number of prints

x 10 P.121

2 Battery check , P.13

3 Sound record P.81

4 Protect P.95

5 Record mode SHQ, HQ, SQ1, SQ2 P.73

6 Resolution 2288×1712, 1600×1200, 640×480, 
etc.

P.73

7 Exposure compensation -2.0, -1.5, -1.0, -0.5, +0.5, +1.0, +1.5, +2.0 P.77

8 White balance WB AUTO, , , , P.79

9 Date and time 04.02.10  12:30 P.29

10 File number (still picture), Number of frames
Elapsed time/Total recording time (movie) 

100-0016, 16 
00:00/00:15 -

11 Movie P.92

2
1

5

7

2

8
9
10

5
66

10

8

9

Still picture Movie

4 4
3

3

11

Note
12
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Memory gauge
The memory gauge lights up when you take a still picture. While the gauge is 
lit, the camera is storing the picture on the card. The memory gauge indica-
tion changes as shown below depending on the shooting status.
The indication is not displayed during movie recording.

Battery check
If the remaining battery power is low, the battery check indication on the 
monitor changes as follows while the camera is turned on. 

Before
shooting

(Gauge is off)

No more pictures can be 
taken (Fully lit).

Wait until the gauge returns 
to the status on the left to 

take the next shot. 

One picture
taken
(Lit)

Two or more taken
(Lit)

Shoot Shoot Shoot

Wait

Lit (Green)
(The indicator turns 

off after a while)
Remaining power 

level: high.

Green lamp and orange lamp on 
the right of the viewfinder blink. 

Remaining power level: exhausted.
Replace with new batteries. 

Blinks (Red)

Remaining power level: low.
Prepare new batteries.

No indication
13
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How to use this manual

This sample page is only for your reference. It may differ from the actual page 
in this manual.

Indications used in this manual
Important information on factors which may lead to a malfunctions 
or operational problems. Also warns of operations that should be 
absolutely avoided. 

Useful information and hints that will help you get the most out of 
your camera. 

Reference pages describing details or associated information. 

Follow the arrows to perform menu operations. For details on 
operating procedures, see "How to use the menus" (P.33).

The buttons for various 
functions and their 
location are clearly 
illustrated.

   and  indicate which button 
to press on the arrow pad. (The up or 
down buttons are used in this example.)

Note
14



1

G
etting started

Attaching the strap

1 Thread the short end of the 
strap through the strap 
eyelet. 

2 Thread the long end of the 
strap through the loop that 
has already gone through 
the eyelet. 

3 Pull the strap tight, making 
sure that it is securely 
fastened and does not come 
loose.

• Be careful with the strap when you carry the camera, as it can easily 
catch on stray objects, causing serious damage. 

• Attach the strap correctly following the procedure so that the camera 
does not fall off. If the strap is attached incorrectly and the camera falls 
off, Olympus is not responsible for any damages. 

Strap eyelet

Note
15
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Loading the batteries
This camera uses 1 CR-V3 lithium battery pack, 2 AA (R6) alkaline batteries 
or NiMH batteries. 

1 Make sure that:

2 Slide the battery compartment 
cover in the direction of .
• The battery compartment cover is 

unlocked and opened in the direction of  
. 

• Use the ball of your finger to slide the 
cover. Do not use your fingernail as this 
could result in injury.

Important
• CR-V3 lithium battery cannot be recharged. 
• Do not peel off the label from a CR-V3 lithium battery pack.
• Manganese (zinc-carbon) batteries cannot be used.

The lens barrier is 
closed.

The lamp on 
the right of the viewfinder 

is off.

The monitor is
off.

Battery compartment 
cover
16



Loading the batteries
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3 Insert the batteries, making sure that they are correctly 
oriented as shown in the illustration.
The battery insertion direction mark is provided inside of the battery 
compartment.

4 Close the battery compartment 
cover, and press it down  
and slide it in the direction 
shown .
• If the battery compartment cover seems 

hard to close, do not force it. With the 
battery compartment cover shut, press 
the  mark firmly and push it in the 
direction indicated by . 

• If the camera is left for about 3 days with the batteries removed, the date 
and time setting will revert to the factory default setting.

When using AA (R6) batteries When using a CR-V3 lithium 
battery pack

Battery insertion 
direction mark When using a CR-V3 lithium 

battery pack, insert it in the 
direction as shown in the 
illustration.

There is a mark showing the 
correct way to insert the AA 
batteries on the bottom of the 
camera. 

Note

The amount of power consumed varies considerably depending on the 
operations performed on the digital camera. If you use exhausted 
batteries or alkaline batteries, the camera may turn off without displaying 
the battery level warning (P.13). 

Precautions when using batteries
17



1

Loading the batteries

G
etting started
Selecting optional batteries or an AC adapter

In addition to the batteries provided with the camera, the following types of 
battery or AC adapter can be used. Choose the power source best suited to 
the situation. 

CR-V3 lithium battery pack (Not rechargeable)
Since the CR-V3 lithium battery pack has a long service life, it is convenient 
when traveling. 

NiMH batteries (Rechargeable batteries)
Olympus NiMH batteries are rechargeable and economical. However, 
charging the batteries repeatedly before using up their capacity will shorten 
the life of the batteries per charge gradually. 

AA (R6) alkaline batteries
When you need batteries in a hurry, you can use AA (R6) alkaline batteries, 
which are easy to obtain anywhere. However, the number of pictures that you 
can take may vary considerably depending on the battery manufacturer, 
shooting conditions, etc. Turn off the monitor whenever possible to save 
power. 

AC adapter
An optional Olympus CAMEDIA-brand AC adapter allows you to power your 
digital camera from a common AC wall outlet. Be sure to use the specified AC 
adapter. An AC adapter is useful for time-consuming tasks such as 
downloading or printing out of images. 
Use an AC adapter designed to operate on the AC voltage in the area the 
camera is being used. 
Consult your nearest Olympus dealer or Service center for details. 
 

DC-IN jack (black)

AC wall outlet

Power plug

AC adapter

Connection cord 
plug

DC-IN jack cover
18
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• Manganese (zinc-carbon) batteries cannot be used. 
• If the battery power runs out while the camera is connected to a PC or 

printer, the image data may be lost or damaged. You are recommended 
to use the AC adapter when transferring images to a PC. Do not connect 
or disconnect the AC adapter while the camera is communicating with 
the PC or printer.

• Do not remove or load the batteries or connect or disconnect the AC 
adapter while the camera is turned on. Doing so could affect the 
camera’s internal settings or functions.

• The life of battery packs may vary according to the type of battery, 
manufacturer, shooting conditions, etc. 

• Power is consumed continuously during the conditions below. This 
could shorten the life of the batteries. 

• When the monitor is in the playback mode for an extended period 
of time. 

• Repeated zoom adjustments.
• Repeated auto-focus by depressing the shutter button halfway. 
• When the camera is connected to a PC or printer.

• Carefully read the AC adapter’s instructions before use.
• When using an AC adapter, the AC adapter supplies power to the 

camera even if batteries are loaded in the camera. The AC adapter does 
not charge batteries in the camera.

Note
19
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Inserting a card
"Card" in this manual refers to the xD-Picture Card. The camera uses the card 
to record pictures.

Card basics

The card corresponds to normal camera film for recording the pictures you 
have taken. 
Pictures recorded and stored on the card can easily be erased, overwritten, 
and/or edited on a PC. 
1 Index area

You can write down the card’s contents. 
2 Contact area

Comes into contact with the camera’s signal read 
contacts. 

Compatible cards
• xD-Picture Card (16 to 512 MB)

• This camera may not recognize a non-Olympus card or a card that was 
formatted on another device (such as a PC, etc.). Before use, be sure to 
format the card on this camera. "CARD SETUP - Formatting cards" 
(P.107)

1

2

Note
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1 Make sure that:

2 Open the card cover.

3 Face the card the correct way and 
insert it into the card slot as 
shown in the illustration. 
• Insert the card while keeping it straight.
• The card stops with a click when it is 

inserted all the way.
• Inserting the card the wrong way or at an 

angle could damage the contact area or 
cause the card to jam. 

• If the card is not inserted all the way, 
data may not be written to the card. 

4 Close the card cover securely.

The lens barrier is 
closed.

The lamp on 
the right of the viewfinder 

is off.

The monitor is
off.

Card cover

Notch

The position of the card 
inserted correctly

Index area side of the card
21
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Removing the card

1 Make sure that:

2 Open the card cover.

3 Push the card all the way in to 
unlock it, and let it return slowly. 
• The card is ejected a short way and then 

stops.
 

4 Hold the card straight and pull it 
out. 

• Do not press on the card with hard or pointed items such as ballpoint 
pens.

• Never open the card cover, or remove the card or the batteries while the 
camera is turned on. Doing so could destroy the data on the card. Once 
destroyed, data cannot be restored.

• Do not place a sticker or label on the card as this could prevent the card 
from being ejected.

The lens barrier is 
closed.

The lamp on 
the right of the viewfinder 

is off.

The monitor is
off.

Releasing your finger quickly after pushing the 
card all the way in may cause it to eject forcefully 
out of the slot. 

Note

Note
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Power on/off
When shooting pictures (Shooting mode)

Power on: Open the lens barrier fully.
The camera turns on in the shooting mode. The lens 
extends and the subject is displayed on the monitor.
If the lens does not extend when the lens barrier is opened, 
there is a possibility that the barrier is not fully open. Open 
the lens barrier fully until you feel it click. 

Power off: Close the lens barrier slightly until it almost touches 
the lens barrel. 
The lens barrier stops just before it touches the lens and the 
lens retracts. Wait until the lens is fully retracted before 
closing the lens barrier completely. 
The camera turns off. (The monitor also turns off.)
23
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TIPS  
• To save battery power, the camera automatically enters the sleep mode 

and stops operating if not used for 3 minutes. If the monitor is on, it will 
automatically turn off. The lens retracts automatically 5 minutes after 
that. The camera activates again as soon as you lightly press the shutter 
button or zoom lever. Whenever possible, turn the camera off when you 
do not intend to take any pictures for a while. 

• Do not push the lens barrier forcefully against the lens as this may 
damage the lens or cause it to malfunction.

When playing back pictures (Playback mode)
Power on: Press (playback) with the lens barrier closed. 

The camera turns on in the playback mode. The monitor 
turns on and the last picture taken is displayed.
If no pictures have been taken yet, or the xD-Picture card is 
empty, the message “NO PICTURE” is displayed on the 
monitor.

Power off: Press .
The monitor and the camera turn off.

Note

Playback button ( )

Playback button ( )
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TIPS  
• When the camera turns on, the monitor may light up momentarily and a 

picture may be displayed briefly. This is not a malfunction. 

• Never open the card cover, remove the card or the batteries, or connect 
or disconnect the AC adapter while the camera is turned on. Doing so 
could destroy all data on the card. Destroyed data cannot be restored. 
When changing the card, be sure to turn the camera off before opening 
the card cover.  

The power is on when:

The lens is extended The monitor is turned on
• Even if the monitor is turned off, the camera still consumes battery power 

when the lens is extended.

The power is off when:

The lens barrier is closed The monitor is turned off

Note

or

and
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Startup/Shutdown screen

This image is displayed on the monitor each time 
the camera is turned on or off. You can also use 
your favorite image. (P.113) 

If the card is not recognized (card check)

When the power is turned on, the camera checks the card automatically. 
If there is no card in the camera or a card that is not supported by this camera 
is inserted, one of the following screens will be displayed. 

• All data stored on the card is erased when the card is formatted. 

Monitor 
indication Corrective action

NO CARD

There is no card in the camera or the card is not 
inserted properly. 
→ Insert a card. If a card is already inserted, remove it 

and insert it again correctly.
The card cannot record, play back or erase pictures. 
Replace with a new card, or format the card. 
→ Press  to select POWER OFF, and press 

. Replace it with a new one.
→ Format the card.

Press  to select FORMAT, and press  
to display the confirmation screen. Select YES and 
press . 
Formatting starts. If the card was successfully 
formatted, the camera is ready to take pictures. 

Startup/Shutdown screen
(Factory default setting)

Note

POWER%OFF

FORMAt

CARD%SEtUP

SELECt GO
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Selecting a language
You can select a language for on-screen display. This reference manual 
shows the English on-screen display in the illustrations and explanations.
Available languages vary depending on the area where you purchased this 
camera. 

1 Open the lens barrier fully.

2 Press . 
• The top menu is displayed. 

3 Press  on the arrow pad to select 
MODE MENU.

4 Press  to select the SETUP tab, 
and press .

OK button
Arrow pad 

Top menu

SETUP tab
27
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5 Press  to select , and 
press .
• The green frame moves to the selected 

item. 

6 Press  to select a language, 
and press .

7 Press  again to exit the menu.

8 Close the lens barrier to turn the 
camera off. 

TIPS  
• The language can also be set from the playback mode. 

ENGLISH

DEUtSCH

SELECt GO

FRANCAIS

ESPAÑOL
28
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Setting the date and time
1 Open the lens barrier fully.

2 Press .
• The top menu is displayed. 

3 Press  on the arrow pad to select 
MODE MENU.

4 Press  to select the SETUP tab, 
and press . 

5 Press  to select , and 
press .
• The green frame moves to the selected 

item. 

OK button
Arrow pad 

Top menu

SETUP tab
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Setting the date and time
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6 Press  to select one of the 
following date formats: Y-M-D 
(Year/Month/Day), M-D-Y (Month/
Day/Year), D-M-Y (Day/Month/Year). 
Then press .
• Move to the year setting.
• The following steps show the procedure 

used when the date and time settings are 
set to Y-M-D. 

7 Press  to set the year, and 
press  to move to the month 
setting. 
• To move back to the previous setting, 

press .
• The first two digits of the year are fixed.

8 Repeat this procedure until the 
date and time are completely set.
• The camera only displays the time in 24-hour time system ("2. p.m." 

would be "14:00").

9 Press . 
• For a more accurate setting, press  

when the time signal hits 00 seconds. 
The clock starts when you press the 
button.

10 Close the lens barrier to turn the 
camera off. 

• The current settings are retained even when the power is turned off, 
unless they are readjusted.

• The date and time settings will be returned to the factory default settings 
if the camera is left without the battery for approximately 3 days. The 
settings will be canceled more quickly if the batteries were only loaded 
in the camera for a short time before being removed. Before taking 
important pictures, check that the date and time settings are correct. 

TIPS  
• The date and time can also be set from the playback mode.

OK button

Note
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Holding the camera
Hold the camera firmly with both hands while keeping your elbows at your 
sides to prevent the camera from moving. 
When taking pictures in the vertical position, hold the camera to position the 
flash above the lens.
Keep your fingers and the strap away from the lens and flash. 

Correct grip:

Incorrect grip:

• Clear pictures cannot be obtained if the camera moves as the shutter 
button is pressed. Hold the camera correctly, and press the shutter 
button gently. 

Horizontal grip Vertical grip

×

Note
31



2

A
bout the m

enus
2 About the menus
Types of menus

When you turn on the camera and press , the top menu is displayed on 
the monitor. The functions of this camera are set from the menus. 
This chapter explains how the menus work, using the shooting mode screens. 

Shortcut Menus

• Take you directly to the setting 
screens. 

• Display operational buttons at 
the bottom of the screen. 

Mode Menus

• Categorizes the settings into 
tabs. 

• Displays the tabs of each 
menu.
Select the desired tab on the 
left of the screen by pressing 

.

Select a menu using the 
arrow pad. 

Press . 
The top menu is displayed. 

Arrow pad ( )

OK/Menu button

Tab
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How to use the menus

1 Press  to display 
the top menu. 
Press . 

Top menu CAMERA tab

PICTURE tab

CARD tab

SETUP tab

2 Press  to select 
a tab, and press . 

Press  
to return to 
the tab 
selection 
screen. 

SE
t

CA
M

PIC
CA
RD

CARD%SEtUP

OK button
Arrow pad 
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• Not all items can be selected depending on the status of the camera and 
the settings performed. 

• In the shooting mode, you can take pictures by pressing the shutter 
button even with the menu being displayed.

• If you want to save the settings after the camera is turned off, set ALL 
RESET to OFF. "ALL RESET - Saving the camera's settings" 
(P.105)

4 Press  to 
select a setting. 
Press  to 
complete setting. 
Press  again to 
exit the menu and 
return to shooting 
status. 

The green frame 
moves to the selected 
item.

 or 

3 Press  to 
select an item, and 
press . 

To return to 
select an item, 
press  or .

Note
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Shortcut menus

Shooting mode

Shortcut menus are frequently used menus that can be accessed from the top 
menu. 

Selects the shooting mode from  (Single-frame shooting) 
and  (Sequential shooting). P.68

Selects whether to record sound when shooting a movie. P.83

Sets the image quality and resolution. 
Still picture : SHQ, HQ, SQ1, SQ2
Movie : HQ, SQ

P.73

Sets whether or not the monitor is turned on when the camera is 
turned on. If the monitor is set not to turn on, the top menu 
displays MONITOR ON when the camera is turned on. 

P.49

Top menu in still 
picture shooting

Top menu in movie 
recording

DRIVE

  (movies)

MONITOR OFF (MONITOR ON)
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Playback mode

Runs through all saved pictures one after another. It is displayed 
when the camera is playing back still pictures. P.90

Plays back movies. It is displayed when a movie is selected. P.92

Displays all the shooting information on the monitor. P.109

Erases the selected still picture or movie. P.96

MODE%MENUINFO

ERASE

Top menu when playing 
back still pictures

Top menu when playing 
back a movie

MOVIE PLAYBACK

INFO

ERASE
36
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Mode Menus

The MODE MENU has 4 tabs. Press  to select a tab and display the 
associated menu items. 

Shooting mode

CAMERA tab

ESP/ Selects the metering method from ESP 
and . P.67

Adjusts the brightness of the image 
(Exposure compensation). P.77

DIGITAL ZOOM
Enables the zoom shooting at larger 
magnification than the maximum optical 
zoom.

P.58

 (still pictures) Sound can be recorded when taking still 
pictures. P.81

Allows pictures to be taken as close as 
7 cm/2.8" from the subject. P.65

PANORAMA Allows panorama pictures to be taken 
with Olympus CAMEDIA-brand cards. P.69

2 IN 1
Combines two still pictures taken in 
succession and stores them as a single 
picture. 

P.71

PICTURE tab

WB Sets the appropriate white balance 
according to the light source. P.79

CAMERA tab

PICTURE tab

CARD tab

SETUP tab
37
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CARD tab
CARD SETUP Formats a card. P.107

SETUP tab

ALL RESET
Selects whether to keep the current 
camera settings when you turn off the 
power. 

P.105

Selects a language for on-screen 
display. P.27

PW ON/OFF SETUP
Sets the picture that is displayed on the 
monitor when the power is turned on and 
off.

P.113

Selects whether the beep sound (used 
for warnings, etc.) should be turned on or 
off. 

P.112

REC VIEW Selects whether to display pictures on 
the monitor while saving them to a card. P.111

FILE NAME Changes how file names are assigned. P.116

PIXEL MAPPING Checks the CCD and image processing 
functions for errors. P.117

Adjusts the brightness of the monitor. P.110

Sets the date and time. P.29

VIDEO OUT
Selects NTSC or PAL according to your 
TV’s video signal type. TV video signal 
types differ depending on the region. 

P.118

CAMERA tab

PICTURE tab

CARD tab

SETUP tab
38
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Playback mode

PLAY tab
Protects pictures from accidental 
erasure. P.95

Rotates pictures 90 degrees clockwise 
or counterclockwise. P.87

Stores print reservation information on 
the card. P.119

Adds sound to a still picture already 
taken. P.94

EDIT tab

BLACK&WHITE Creates a black and white picture and 
saves it as a new picture. P.99

SEPIA Creates a sepia-toned picture and saves 
it as a new picture. P.99

Makes the file size smaller and saves it 
as a new file. P.100

INDEX Creates an index picture of a movie in 9 
frames. P.102

EDIT Edits a movie. P.103

CARD tab

CARD SETUP Erases all image data stored on the card. 
(ALL ERASE, FORMAT)

P.97
P.107

PLAY tab

EDIT tab

CARD tab

SETUP tab
CA
RD

SE
t

ED
It
P
L
A
Y
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SETUP tab

ALL RESET
Selects whether to keep the current 
camera settings when you turn off the 
power. 

P.105

Selects a language for on-screen 
display. P.27

PW ON/OFF SETUP
Sets the picture that is displayed on the 
monitor when the power is turned on and 
off.

P.113

SCREEN SETUP
Registers a picture you took to be 
displayed on the startup/shutdown 
screen. 

P.114

Selects whether the beep sound (used 
for warnings, etc.) should be turned on or 
off. 

P.112

Adjusts the brightness of the monitor. P.110

Sets the date and time. P.29

VIDEO OUT
Selects NTSC or PAL according to your 
TV’s video signal type. TV video signal 
types differ depending on the region. 

P.118

Selects the number of frames in the 
index display. P.88

PLAY tab

EDIT tab

CARD tab

SETUP tab
40
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3 Shooting basics

Shooting mode
This camera allows you to take still pictures and record movies. This camera 
has 7 shooting modes to choose from depending on the shooting conditions 
and the effect you want to achieve.The factory default setting of the shooting 
mode is PROGRAM AUTO. For normal shooting which does not require any 
special setting or effect, you do not need to follow this procedure.

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on. 

2 Press  ( ).  

• The screen for selecting the shooting 
mode (virtual dial) is displayed. 

Shooting mode button 
( )

PROGRAM AUtO

SELECt GO

Virtual dial screen
41
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Shooting basics
3 Select the mode best suited to your purpose from the 
following.
• Press  to select the mode.

4 Press . 
• The shooting mode is set, and the virtual dial screen disappears. Even 

if the  button is not pressed, the mode will be set and the screen will 
disappear.

 PROGRAM AUTO (Factory default setting)
Used for regular photography. The camera automatically makes the settings 
for natural color balance. Other functions, such as the flash mode and 
metering, can be adjusted manually. 

 (Portrait)
Suitable for taking a portrait-style shot of a person. The camera automatically 
sets the optimal shooting conditions. 

(Landscape + Portrait)
Suitable for taking photos of both your subject and the landscape. The 
camera automatically sets the optimal shooting conditions.

 (Landscape)
Suitable for taking pictures of landscapes and other outdoor scenes. The 
camera automatically sets the optimal shooting conditions. 

PROGRAM AUtO

SELECt GO SELECt GO

PORtRAIt

SELECt GO

LANDSCAPE
+ PORtRAIt

SELECt GO

LANDSCAPE

SELECt GO

MOVIE

SELECt GO

SELF PORtRAIt

SELECt GO

NIGHt SCENE
42
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 (Night scene)
Suitable for shooting pictures in the evening or at night. The camera sets a 
slower shutter speed than is used in normal shooting. If you take a picture of 
a street at night in any other mode, the lack of brightness will result in a dark 
picture with only dots of light showing. In this mode, the true appearance of 
the street is captured. The camera automatically sets the optimal shooting 
conditions. If you use the flash, you can take pictures of both your subject and 
the night background. "Night scene mode" (P.53)

 (Self portrait)
Enables you to take a picture of yourself while 
holding the camera. Point the lens towards 
yourself and the focus will be locked on you. 
The camera automatically sets the optimal 
shooting conditions. The zoom is fixed in the wide 
position and cannot be changed.

(Movie)
Lets you record movies. Sound is recorded at the same time. The focus and 
zoom are locked. If the distance to the subject changes, focus may be 
compromised. "Recording movies" (P.55)

TIPS  
• For details of the functions for each mode "List of items by shooting 

mode" (P.155)

• In the night scene mode, the sequential shooting or two-in-one 
picture function is not available.

• In the self-portrait mode, the digital zoom, super macro and panorama 
shooting are not available.

Normal shooting 
(Flash fires.)

Night scene mode 
(Flash fires.)

Note
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Taking still pictures
You can take still pictures using either the monitor or the viewfinder. Both 
methods are easy as all you have to do is to press the shutter button.

Taking still pictures using the monitor

With the monitor, you can shoot while checking the picture area that the 
camera actually records. 

1 Open the lens barrier fully.
• Slide the lens barrier fully open until it 

clicks. 
• The lens extends and the monitor turns 

on.

2 Decide the composition 
while looking at the 
image on the monitor. 

Shooting mode (P.41)
AF target mark (P.11)

Number of storable still 
pictures (P.74)
Memory gauge (P.13)
Flash standby/Flash charge

This indicates the same status as 
the orange lamp on the right of the 
viewfinder. (P.46)

Green lamp
This indicates the same status as 
the green lamp on the right of the 
viewfinder. (P.46)
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3 Press the shutter button gently 
(halfway) to adjust the focus. 
• Focus and exposure are locked, when the 

green lamp lights steadily. (Focus Lock)
• When the flash is ready to fire, the  mark 

lights. 

4 Press the shutter button all the way 
(fully).
• The camera takes the picture, and a beep 

sounds. 
• When the green lamp stops blinking, you can 

take the next picture. 
• The orange lamp on the right of the viewfinder 

blinks while the picture is stored on the card.

TIPS  
The monitor turns off automatically. 

→If the camera is not used for over 3 minutes, the monitor turns off
automatically. The lens retracts automatically 5 minutes after that.
Touch the shutter button or zoom lever to turn the monitor on. 

The monitor is hard to see. 
→Bright light, such as direct sunlight, may cause vertical lines to appear

on the monitor screen. In this case, use the viewfinder. (Note that this
does not affect recorded pictures.)

Shutter button

Shutter button
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Taking still pictures using the viewfinder

The camera actually records a wider area than the picture you compose while 
looking through the viewfinder. 

1 Open the lens barrier fully.
• Slide the lens barrier fully open until 

it clicks.
• The lens extends and the monitor 

turns on.
"Turning off the monitor" (P.49)

2 Decide the composition while 
looking at the image in the 
viewfinder. 

3 Take the picture by following the same procedure as for 
shooting using the monitor.

"Taking still pictures using the monitor" (P.44)

AF target mark
Orange lamp

Green lamp
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TIPS  
Correct focus cannot be obtained on the subject you want to shoot.

→ "If correct focus cannot be obtained" (P.50)
The green lamp blinks. 

→You are too close to the subject. Take the picture at least 20 cm (7.9")
away from the subject. If you use the super macro mode, you can
take pictures as close as 7 cm/2.8" from the subject.

"Super macro mode shooting" (P.65)
→Depending on the subject, the focus may not be locked.

"If correct focus cannot be obtained" (P.50)
The orange lamp blinks when the shutter button is pressed halfway. 

→The flash is charging. While the orange lamp is blinking quickly after
shooting, the picture you just took is being stored. Wait until the lamp
goes off. 

To check the picture you have just taken immediately. 
→Set REC VIEW to ON.

"REC VIEW" (P.111)

• Press the shutter button gently using the ball of your finger. If it is 
pressed hard, the camera may move, resulting in a blur. 

• Never open the card cover, remove the batteries or disconnect the AC 
adapter while the orange lamp is blinking. Doing so could destroy stored 
pictures and prevent storage of pictures you have just taken. 

• When taking pictures against strong backlight, the area of the picture in 
shadow may appear colored. 

Note
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Comparison of the viewfinder & monitor

Viewfinder Monitor
Advantages Camera movement does 

not occur easily and 
subjects can be seen 
clearly even in bright 
places. 
Little battery power is used. 

You can check the picture 
area that the camera 
actually records more 
accurately. 

Disadvantages When close to a subject, 
the image in the viewfinder 
is a little different from the 
picture that the camera 
actually records. 

Camera movement can 
occur easily and subjects 
may be difficult to see in 
bright/dark places. The 
monitor uses more battery 
power than the viewfinder. 

Tips Use the viewfinder for 
general snapshots 
(landscape pictures, casual 
shots, etc.).

Use the monitor when you 
want to shoot while 
checking the picture area 
that the camera actually 
records, or when you take 
close-up shots of people or 
flowers (macro shooting). 

• The camera records a wider area than the image in 
the viewfinder. 

• As you get closer to the subject, the actual image 
recorded becomes lower than the one in the 
viewfinder (see left). 
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Turning off the monitor

You can set whether or not the monitor is turned on when turning the camera 
on in the shooting mode.

1 Press .
• The top menu is displayed. 

2 Press  on the arrow pad (OFF).

3 The monitor turned off.
• Pressing  to display the top menu, and 

press  again turns the monitor on (ON). If the MONITOR OFF is set, 
the top menu displays MONITOR ON. 

OK button
Arrow pad 
49
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If correct focus cannot be obtained
When correct focus cannot be obtained on the subject you want to shoot, you 
can focus the camera on another point at roughly the same distance (focus 
lock) and take the picture as explained below.

Determine the position of the subject after focusing (Focus Lock)

1 Open the lens barrier fully.
• The camera turns on in the shooting 

mode. 
• The lens extends and the monitor 

turns on.

2 Position the AF target mark on 
the subject you want to focus on. 
• When shooting a hard-to-focus 

subject, point the camera at an object 
about the same distance away as the 
subject. 

3 Press the shutter button 
halfway until the green lamp 
lights. 
• When the green lamp lights steadily, 

the focus and the exposure are locked. 
• When the green lamp blinks, the 

focus and exposure are not locked. 
Release your finger from the shutter button, re-position your subject 
and press the shutter button halfway again. 

AF target mark

Shutter button
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4 Keeping the shutter button 
pressed halfway, recompose 
your shot.

5 Press the shutter button fully. 

TIPS  
The green lamp blinks. 

→You are too close to the subject. Take the picture at least 20 cm (7.9")
away from the subject. If you use the super macro mode, you can
take pictures as close as 7 cm/2.8" from the subject.

"Super macro mode shooting" (P.65)
→Depending on the subject, the focus may not be locked.

"Subjects that are difficult to focus on" (P.52)

Green lamp

Shutter button
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Subjects that are difficult to focus on

Under certain types of conditions, the auto focus may not work properly. If this 
happens, focus on an object with high contrast at the same distance as the 
intended subject (focus lock), recompose your shot and then take the picture. 
If the subject has no vertical lines, hold the camera vertically and focus the 
camera using the focus lock function by pressing the shutter button halfway, 
and return the camera to the horizontal position while keeping the button 
pressed halfway and take the picture. 

The green lamp 
blinks. 
The subject cannot 
be brought into focus. 

The green lamp lights, 
but the subject cannot 
be brought into focus. 

Subject with low 
contrast 

Subject with an 
extremely bright area in 
the center of the frame

Subject without 
vertical lines

Subjects at different 
distances

Fast-moving subject The subject to be 
focused on is not in the 
center of the frame.
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Night scene mode

Setting the mode to Night scene allows you to take landscape shots at night 
under optimum conditions. In this mode, the shutter speed is not fixed to 1/30 
second maximum when the flash is activated. Depending upon the subject or 
shooting conditions, shutter speed may extend up to 2 seconds. The noise 
reduction function activates automatically reducing ‘noise’ when the shutter 
speed is over 1/2 second.This function reduces electrostatic ‘noise’ that 
occurs with long exposure shots. 

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on. 

2 Press  ( ) to display the virtual 
dial screen (the screen for 
selecting the shooting mode). 

3 Press to  to select , then 
press .
• Night scene mode is set and the camera 

returns to the shooting mode.
• The night scene mark  appears on the 

monitor.

Noise Reduction: Off Noise Reduction: On

OK button
Arrow pad 

SELECt GO

NIGHt SCENE

Virtual dial screen
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4 Take the picture.
• If the shutter speed is more than 1/2 second, the noise reduction 

function will automatically be activated. During processing, the 
CAPTURE screen is displayed and the green and orange lamps blink.

• This function may not work effectively with some shooting conditions or 
subjects. 

• The prior flash setting is maintained in the night scene mode. 
• The flash mode is set independently from the night scene mode. 

"Using the flash" (P.60)
• Since the shutter speed is slow, make sure you stabilize the camera by 

using a tripod or set it on a level surface. 

Note
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Recording movies

You can record movies with this camera. Sound is recorded at the same time. 
The focus and zoom are locked. If the distance to the subject changes, focus 
may be compromised. 

"INDEX - Creating an index" (P.102)

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on. 

2 Press   ( ) to display the virtual 
dial screen.

3 Press to  select , then press 
.

• Movie recording is set and the camera 
returns to the shooting mode.

• On the monitor, the  mark and the 
remaining recording time of the current 
memory card are displayed.

4 Decide the composition while 
looking at the image on the 
monitor. 

5 Press the shutter button halfway.

OK button
Arrow pad 

SELECt GO

MOVIE

Virtual dial screen

Remaining recording time

 mark
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Recording movies

Shooting basics
6 Press the shutter button fully to start recording. 
• The orange lamp on the right of the viewfinder lights. 
• While recording a movie, the camera fixes its focus and zoom.
• During movie recording,  lights red.

7 Press the shutter button again to stop recording. 
• The orange lamp blinks while the movie is stored on the card. 
• When the remaining recording time has been used up, recording stops 

automatically. 

TIPS  
To keep your subject in focus all the time while shooting
→Set  to OFF. "Recording sound with movies" (P.83)

To use the zoom while shooting
→Set DIGITAL ZOOM to ON. "Using the digital zoom" (P.58)
→Set  to OFF, and you can use the optical zoom while shooting. 

"Recording sound with movies" (P.83)

• During movie recording, the flash is disabled. 
• It takes longer to store movies than still pictures. 
• The maximum recordable time varies depending on the conditions such 

as the record mode.
Note

• Recording will continue until the card is full unless stopped by 
pressing the shutter button.

• A long recorded movie cannot be edited. (P.101)
• If a single movie recording uses up all of the card’s memory, create 

space on the card by deleting the movie or downloading it to a PC.

Notes for recording movies over a long time
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Shooting basics
Zoom

Telephoto and wide-angle shooting are possible at 3x magnification (the 
optical zoom limit, equivalent to 35 mm – 105 mm on a 35 mm camera). By 
combining the optical zoom with the digital zoom, zoom magnification can be 
increased to a maximum of approximately 12x .

Using the optical zoom

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on.

2 Push/pull the zoom lever while 
observing the subject on the 
monitor. 

3 Take the picture. 

Zoom lever

Wide-angle: Push the zoom lever 
toward W to zoom out.

Telephoto: Pull the zoom lever 
toward T to zoom in.
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Shooting basics
Using the digital zoom

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on.

2 Press . 
• The top menu is displayed. 

3 Press  to select MODE MENU. 

4 Press  to select the CAMERA 
tab, and press .

5 Press  to select DIGITAL 
ZOOM, and press .

OK button
Arrow pad 

Zoom lever
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Shooting basics

6 Press  to select ON, and 
press .
• Press  again to exit the menu and 

return to the shooting status. 

7 Pull the zoom lever toward .
• The white area of the zoom indicator 

indicates the optical zoom. If the digital 
zoom is set to ON, a red area appears on 
the zoom indicator. The digital zoom is 
enabled when you reach the limit of the 
optical zoom and then pull the zoom lever 
toward T.

8 Take the picture. 

• Pictures taken with the digital zoom may appear grainy. 
• Camera movement is likely to occur at higher magnifications. Stabilize 

the camera with a tripod, etc. to avoid camera movement. 
• Turning the monitor off cancels the digital zoom, and the camera takes 

a picture at the specified optical zoom magnification. It will be 
automatically enabled the next time you turn the monitor on.

• You cannot use the digital zoom in Self-Portrait mode.

The cursor moves up and 
down on the zoom 
indicator according to the 
zoom magnification.

Note
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Shooting basics
Using the flash
Select the flash mode best suited to the light conditions and the effect you 
want to achieve. 

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on.

2 Press  ( ).
• The current flash setting is displayed.

3 Press  ( ) to change the flash 
mode to your desired setting.
• Each time you press , the flash mode 

changes in the following sequence: 
"Auto-flash" - "  Red-eye reduction 
flash" - "  Fill-in flash" - "  Flash off". 

4 Press the shutter button halfway.
• When the flash is set to fire, the orange lamp remains lit. 

5 Press the shutter button fully to take the picture. 
Flash working range
W (max.): Approx. 20 cm to 3.4 m (0.7 ft. to 11 ft.)
T (max.) : Approx. 20 cm to 2.0 m (0.7 ft. to 7 ft.)

TIPS  
The orange lamp or  (flash standby) indication blinks.

→The flash is charging. Wait until the orange lamp goes off.

Flash mode 
button ( )
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• The flash does not fire in the following situations:
When shooting in the movie record mode. 
during sequential shooting ( ), panorama shooting or super 
macroshooting ( )

• The flash may not give you the optimum result in the macro mode, 
especially with wide-angle shooting. Check the resulting picture on the 
monitor. 

Auto-flash (No indication)
The flash fires automatically in low light or backlight conditions. 
To shoot a subject with backlight, position the AF target mark over the 
subject. 

Red-eye reduction flash ( )
The light from the flash may make the subject’s eyes appear red in the 
picture. The red-eye reduction flash mode significantly reduces this 
phenomenon by emitting pre-flashes before firing the regular flash. This helps 
accustom the subject’s eyes to the bright light and minimizes the red-eye 
phenomenon. 

• After the pre-flashes, it takes about 1 second before the shutter is 
released. Hold the camera firmly to avoid camera movement. 

• Effectiveness may be limited if the subject is not looking directly at the 
pre-flashes, or if the shooting range is too far. Individual physical 
characteristics may also limit effectiveness. 

Note

The subject’s eyes appear red.

Note
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Shooting basics
Fill-in flash ( )
The flash fires regardless of the available light.This mode is useful for 
eliminating shadows on the subject’s face (such as shadows from tree 
leaves), in a backlight situation, or for correcting the color shift produced by 
artificial lighting (especially fluorescent light).

• The fill-in flash may not have the desired effect under excessively bright 
light. 

Flash off ( )
The flash does not fire even in low light conditions. Use this mode in situations 
where flash photography is not desired or is prohibited. You can also use this 
mode when you want to shoot a natural-looking twilight or night scene. 

• Since a slow shutter speed is automatically selected in low light 
situations when in the flash off mode, the use of a tripod is 
recommended to prevent your pictures from being blurred by camera 
movement. 

Note

Note
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4 Advanced shooting
Macro mode shooting 

The macro mode allows you to shoot at a distance of 20 cm to 50 cm (0.7 ft. 
to 1.6 ft.) from your subject. 
Regular photographs can be taken, but the camera may take time to focus on 
distant subjects. 

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on.

2 Press  ( ).
• The current setting is displayed. 

Normal shooting With macro mode

Macro button ( )
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3 Press  ( ) to switch the macro 
mode on or off.
• The setting changes between  ON and 

 OFF each time  is pressed. When 
the macro mode is selected,  is 
displayed on the monitor. 

4 Take the picture. 

• If you are close to a subject, the picture in the viewfinder is different from 
the area that the camera actually records. For macro mode shooting, we 
recommend using the monitor. 

• If you use the flash in macro shooting, shadows may be conspicuous 
and the correct exposure may not be achieved. 

Note
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Super macro mode shooting
This mode lets you shoot from as close as 7 cm/2.8" to your subject. 
In the  mode, normal shooting is also possible, but the position of the 
zoom is fixed automatically and cannot be changed.

1 In the shooting mode top menu, 
select MODE MENU  CAMERA  

 and press .
g"How to use the menus" (P.33)

2 Press  to select ON, and 
press .
• Press  again to exit the menu.

3 Take the picture.

• During super macro shooting, the zoom function or a flash is not 
available.

• When taking pictures close to the subject, shadows may become 
conspicuous, making it difficult to maintain correct focus. 

OK button
Arrow pad 

Note
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Self-timer shooting
This function is useful for taking pictures where you want to be included in the 
photograph. Fix the camera securely on a tripod or set it on a level surface for 
self-timer shooting.  

1 Open the lens barrier fully.
• The lens extends and the monitor turns 

on.

2 Press  ( ).
• The current self-timer setting is displayed. 

3 Press  ( ) to switch the self-
timer mode on or off.
• The setting changes between  ON 

and  OFF each time  is pressed. 
When the self-timer mode is selected, 

 is displayed on the monitor.

4 Take the picture. 
• The self-timer lamp lights up for 

approximately 10 seconds, and starts 
blinking. After blinking for approximately 
2 seconds with a beep sound, the 
picture is taken. 

• The self-timer mode is automatically 
canceled after one shot. 

Self-timer 
button ( )

   
  

ON

Self-timer lamp
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Selecting the metering area 
In a backlight situation, your subject may appear dark if the picture is taken 
with the normal metering value (Digital ESP metering). In this case, by 
changing the metering area to the center of the viewfinder screen (Spot 
metering), a subject can be shot with optimal exposure regardless of the 
background light. 

ESP (Digital ESP) : Meters the center of the viewfinder and the area 
around it separately to obtain the optimum 
exposure. 

 (Spot metering) : Meters only the center of the viewfinder to obtain 
the appropriate exposure for the subject. 

1 In the shooting mode top menu, 
select MODE MENU → CAMERA → 
ESP/ , and press .

"How to use the menus" (P.33)

2 Press  to select , and 
press . 
• Press  again to exit the menu. 

3 Take the picture. 

TIPS  
• The camera returns to ESP (factory default setting) when the lens 

barrier is closed.
"ALL RESET - Saving the camera's settings" (P.105)

OK button
Arrow pad 

Note
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Sequential shooting
This function allows you to take a rapid succession of still pictures by pressing 
and holding the shutter button (approximately 8 pictures at 1.3 frames per 
second by Sequential shooting in HQ mode). As you can choose the best 
picture from a series of sequential shots, you are recommended to use this 
mode when taking pictures of a moving subject. Focus, exposure and white 
balance are locked at the first frame. You can also erase the unwanted shots 
afterwards. "Single-frame erase" (P.96)

1 In the shooting mode top menu, 
press  to select DRIVE.

"How to use the menus" (P.33)

2 Press  to select , and 
press .
• Press  again to exit the menu. 

3 Take the picture. 
• Press the shutter button fully and keep it pressed. The camera will take 

pictures in sequence until you release the button. 

• The sequential shooting mode is canceled when the lens barrier is 
closed. "ALL RESET - Saving the camera's settings" (P.105)

• During sequential shooting, the flash is disabled. 
• If the battery power is low and the battery check blinks during sequential 

shooting, shooting stops and the camera starts saving the pictures you 
have taken. Whether or not all of the shots are saved depends on how 
much battery power remains. 

OK button
Arrow pad 

Note
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PANORAMA
You can take advantage of panorama shooting with the Olympus xD-Picture 
Card. Panorama shooting lets you connect pictures with overlapping edges 
into a single panoramic picture, using the CAMEDIA Master software. 

1 In the shooting mode top menu, 
select MODE MENU  → CAMERA  
→ PANORAMA, and press . 

"How to use the menus" (P.33)
• The PANORAMA mode is set. The 

subject is displayed on the monitor. 

2 On the monitor, use the arrow pad 
to choose the direction you want 
the pictures connected. 

: Connects the pictures from left to 
right.

: Connects the pictures from right to 
left.

: Connects the pictures from bottom to 
top.

: Connects the pictures from top to 
bottom.

OK button
Arrow pad 

Connects the pictures from
 left to right.

Connects pictures from 
bottom to top.
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PANORAMA
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3 Make sure that the edges of the pictures overlap, and take 
pictures.
• Focus, exposure and white balance are set by the first picture. Do not 

select an extremely bright subject (such as the sun) for the first picture. 
• You cannot adjust the zoom after the first picture. 
• Panorama shooting is possible for up to 10 pictures. 

• When you have taken 10 pictures, the end 
mark appears. 

4 Press  to finish panorama shooting. 
• The frame on the screen disappears and the camera returns to the 

normal shooting mode. 

• The panorama mode is only available with Olympus CAMEDIA-brand 
cards.

• During panorama shooting, sequential shooting is not available. 
• The camera itself cannot connect panorama pictures. The CAMEDIA 

Master software is necessary to connect the pictures. 

When shooting, make sure that the edges (right/left/top/bottom) of the 
images overlap, so that the CAMEDIA Master software can correctly 
connect the pictures. 

Note
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Taking two-in-one pictures
This function allows you to combine two pictures 
taken in succession and store them as a single 
picture. You can combine two different subjects 
in one picture. 

1 In the shooting mode top menu, 
select MODE MENU → CAMERA → 
2 IN 1, and press . 

"How to use the menus" (P.33)
• The 2 IN 1 mode is set. The subject is 

displayed on the monitor. 

2 Take the first shot while observing 
your subject on the monitor.
• The subject will be positioned on the left in 

the combined picture.

3 Take the second shot. 
• The subject will be positioned on the right 

in the combined picture.

Picture when played back

OK button
Arrow pad 

Picture when shooting
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• During 2 IN 1 mode shooting, the panorama and sequential shooting are 
not available. 

• When the batteries are exhausted (  is displayed), the flash 
automatically turns off. 

• The 2 IN 1 mode is canceled when  is pressed or the lens barrier is 
closed. Press  to cancel the 2 IN 1 picture mode after the first shot 
has been taken. The first picture will not be stored.

• The 2 IN 1 mode is canceled when the camera enters the sleep mode 
after shooting the first picture.

Note
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Selecting a record mode
You can select a record mode in which to take pictures or shoot movies. 
Choose the best record mode for your purpose (printing, editing on a PC, 
website editing, etc.). For details of the available record mode and 
resolutions, and the number of still pictures or the movie recording time 
allowed on the card, refer to the table on the next page. The numbers in the 
table are approximate. 

Record
mode Description Quality File size

SHQ

• A high quality mode. 
• Fewer images can be saved to a card.
• Takes longer to store the images. 

Uses
• Good for printing. 
• Can be enlarged to A4 (210 mm x 

297 mm / 8.3” x 11.7”) size. 
• Good for processing on a PC. 

Clearer

Normal

Larger

Smaller

HQ

• Factory default setting. 

Uses
• Good for editing on a PC or printing 

in postcard size. 

SQ1/SQ2

• The resolutions are smaller than in 
SHQ or HQ. 

• A standard quality mode. 
• More images can be saved to a card. 

Uses
• Attaching images to e-mail or simply 

viewing them on a PC. 
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Still Picture Record Modes 

Movie Record Modes   Maximum time for one recording (sec)

The time remaining for recording movies (Total recording time) in the card is 
displayed on the monitor when the camera is set to the movie record mode 
( ).

• The card memory capacity listed in the table is approximate. 
• The number of remaining pictures may change according to the subject 

or factors like whether print reservations have been made or not. In 
certain instances, the number of remaining pictures displayed on the 
monitor does not change even when you take pictures or stored images 
are erased.

• If movies are shot with VIDEO OUT set to PAL and the AV cable 
connected, the movie recording time will differ from the time listed in the 
Movie Record Modes table.

Record mode Resolution
(No. of pixels)

Memory capacity in number of shots 
(using a 16 MB card)

with sound without sound
SHQ

2288 x 1712
5 5

HQ 15 16

SQ1 1600 x 1200 30 32

SQ2 640 x 480 124 165

Record mode Resolution
Remaining recording time 

(using a 16 MB card)
with sound without sound

HQ 320 x 240 46 sec. 48 sec.

SQ 160 x 120 3 min. 6 sec. 3 min. 31 sec.

Note
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TIPS  
• Resolution

The number of pixels (horizontal x vertical) used when saving an image. 
If the image will be printed, higher resolutions (larger numbers) are 
recommended so that the image will be clearer. However, higher 
resolutions make the file size (amount of data) larger, so the number of 
pictures that can be saved will be fewer. 

• Resolution and picture size on a computer screen
When a picture is transferred to a computer, the size of the picture on 
the computer screen varies depending on the computer’s monitor 
setting. For instance, a picture taken in 1024 x 768 resolution is the 
same size as the screen if you set the picture to 1x when the monitor 
setting is 1024 x 768. However, if the monitor setting is over 1024 x 768 
(such as 1280 x 1024), the picture only takes up part of the screen. 
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1 In the shooting mode top menu, 
press  to select .

"How to use the menus" (P.33)

2 Press  to select the desired 
record mode. 
• For still pictures, you can choose from 

SHQ, HQ, SQ1 and SQ2. 

• For movies, you can choose HQ or SQ. 

3 Press . 
• Press  again to exit the menu. 

 

• The record mode setting returns to HQ (factory default setting) when the 
lens barrier is closed. "ALL RESET - Saving the camera's settings" 
(P.105)

OK button
Arrow pad 

Note
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Varying the image brightness (Exposure compensation)
This function allows you to make fine changes to the automatic exposure 
setting. In some situations, you may get better results when the exposure that 
the camera sets is compensated (adjusted) manually. You can adjust the 
exposure in the range of ±2.0 in 0.5EV steps. 
When the setting is changed, you can check the result on the monitor. 

1 In the shooting mode top menu, 
select MODE MENU → CAMERA → 

, and press . 
"How to use the menus" (P.33)

2 Press  to select the exposure 
compensation value.
• Select a [ + ] value to brighten the image 

or a [ – ] value to darken the image. 

3 Take the picture. 
TIPS  

• Often bright subjects (such as snow) will turn out darker than their 
natural colors. Adjusting toward + makes these subjects closer to their 
real shades. For the same reason, adjust toward – when shooting dark 
subjects. 

OK button
Arrow pad 

−2.0 0.0 +2.0
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• The exposure compensation value returns to 0.0 (factory default setting) 
when the lens barrier is closed. "ALL RESET - Saving the camera's 
settings" (P.105)

• If the flash is used, the image brightness (exposure) may differ from the 
intended brightness. 

• Exposure compensation cannot correct the image if the surroundings of 
the subject are extremely bright or dark. 

Note
78



4

A
dvanced shooting

Adjusting the white balance
Color reproduction differs depending on the light conditions. For instance, 
when daylight, the setting sun, or tungsten lighting are reflected on white 
paper, the shade of white produced will be slightly different for each. By 
setting the WB (white balance), you can achieve more natural-looking colors. 

1 In the shooting mode top menu, 
select MODE MENU → PICTURE → 
WB, and press . 

"How to use the menus" (P.33)

2 Press  to select the white 
balance best suited to the shooting 
conditions. Choose from AUTO, 

, ,  and . 

AUTO (No indication) : The white balance is adjusted automatically so that colors 
look natural irrespective of the light source. 

 (Sunlight) : For natural colors under a clear sky.
(Overcast) : For natural colors under a cloudy sky.

 (Tungsten) : For natural colors under tungsten lighting.

 (Fluorescent) : For natural colors under fluorescent lighting.

3 Press . 
• Press  again to exit the menu. 

4 Take the picture. 

OK button
Arrow pad 
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• The white balance setting returns to AUTO (factory default setting) when 
the lens barrier is closed. "ALL RESET - Saving the camera's 
settings" (P.105)

• White balance may not be effective under some special light sources. 
• After setting a white balance other than AUTO, play back the picture and 

check the colors on the monitor. 
• When the flash is fired with a white balance setting other than AUTO, 

colors may appear different in the resulting picture from the colors you 
see on the monitor. 

Note
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Recording sound with still pictures
Sound can be recorded when taking still pictures. Recording starts about 0.5 
seconds after the shutter is released and lasts about 4 seconds.
When this function is enabled, sound is recorded automatically every time 
you take a picture.

1 In the shooting mode top menu, 
select MODE MENU  CAMERA  

, and press .
"How to use the menus" (P.33)

2 Press  to select ON, and 
press .
• Press  again to exit the menu.

3 When recording starts, turn the 
camera microphone towards the 
source of the sound you want to 
record.
• The BUSY bar is displayed during recording.

OK button
Arrow pad 

Shutter button

Microphone 
81



4

Recording sound with still pictures

A
dvanced shooting
TIPS
•  appears on all still pictures and movies that have recorded 

sound. 
• Sound can be added later to still pictures. Recorded sound can also 

be changed. "Recording sound" (P.94)

• The camera does not have a function to play back recorded sound. 
• If the camera is more than 1 m (3.3 ft.) away from the source of the 

sound, sound may not be recorded clearly.
• It is not possible to take another picture during sound recording.
• Sound recording is not possible when the drive mode is set to sequential 

shooting ( ).
• Recording is disabled in the panorama or two-in-one picture 

shooting. 
• Sound recording may also pick up camera noises, such as button 

operations, shutter movement, etc.
• Sound recording may not be possible if there is insufficient space in 

the card memory.

Note
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Recording sound with movies
Sound can be recorded while shooting a movie.

1 In the movie recording mode top 
menu, press  to select .

"Recording movies" (P.55)
"How to use the menus" (P.33)

2 Press  to select ON, and 
press .
• Press  again to exit the menu.

3 Recording starts at the same time 
as shooting.

• When  is set to ON, the focus and the optical zoom position are 
locked during movie recording. If you wish to use the zoom during 
movie recording, set DIGITAL ZOOM to ON.

• If the camera is more than 1 m (3.3 ft.) away from the source of the 
sound, sound may not be recorded clearly. 

• The camera does not have a function to play back recorded sound. 

OK button
Arrow pad 

Note
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Viewing still pictures

1 Press with the lens barrier 
closed. 

• The monitor turns on and displays the last 
picture taken. (Single-frame playback)

2 Use the arrow pad to play back 
other pictures. 

3 Press to cancel playback. 
• The monitor and camera turn off. 

• If the camera is not used for over 3 minutes, the monitor and camera turn 
off automatically.

Arrow pad 

Playback button ( )

Displays the next 
picture.

Display the previous 
picture. 

Jumps to the picture 10 frames back.

Jumps to the picture 10 frames ahead.

Note
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QUICK VIEW 

This function lets you play back pictures while the camera is in the shooting 
mode. This is useful when you want to check shooting results and resume 
shooting quickly. 
Functions available in normal playback mode are also available in Quick 
View.

1 Press  (QUICK VIEW) while in 
the shooting mode.
• The camera immediately enters the 

playback mode and displays the last 
picture taken. (Single-frame playback)

2 Press the shutter button halfway or 
 to return to the shooting 

mode. 
• The camera returns to shooting mode, and is ready to take pictures. 
• Press the shutter button all the way (fully) to return to the shooting 

mode and take a picture immediately. 

Playback button
(QUICK VIEW )
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Close-up playback

Pictures displayed on the monitor can be enlarged in steps up to 4 times the 
original size. 

1 Press with the lens barrier closed. 
• The monitor turns on and displays the last picture taken. 

2 Use the arrow pad to display the 
still picture you want to enlarge.
• You cannot enlarge pictures with .

3 Pull the zoom lever toward .
• The magnification increases each time the zoom lever is pulled. To 

return the picture to the original size (1x), push the zoom lever toward 
. 

• By using the arrow pad while the enlarged picture is displayed, you can 
shift the picture in the desired direction, enabling you to view a different 
portion. 

• Pictures cannot be stored in an enlarged state.

Playback button ( )
Zoom lever

Arrow pad 

Note
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Picture rotation  

Pictures taken with the camera held vertically are displayed horizontally. 
This function lets you turn such pictures 90 degrees clockwise or 
counterclockwise so that they are displayed vertically. 

1 In the playback mode top menu,
select MODE MENU → PLAY → 

, and press .

2 Press  to select +90° or -90°. 
• The picture is rotated, and displayed 

vertically. 
• To close the menu, press  twice.

 

• The following pictures cannot be rotated. 
Movies, protected pictures, pictures that have been edited on a PC 
and pictures taken with another camera. 

• New picture orientations are saved even when the power is turned off. 

Playback button ( )

Arrow pad 

OK button

+90°Picture when taken-90°

Note
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Index display
This function lets you show several pictures at the same time on the monitor. 
The number of pictures shown can be 4, 9 or 16. "Selecting the number 
of pictures" (P.89)

1 Press with the lens barrier 
closed. 
• The monitor turns on and displays the last 

picture taken. (Single-frame playback)

2 Push the zoom lever toward  
to enter the index display mode.

• Use the arrow pad to select the picture.
: Moves to the next frame.
: Moves to the previous frame.
: Jumps to the previous index display 

(the frames before the top left 
frame).

: Jumps to the next index display (the 
frames following the bottom right 
frame).

• To return to the single-frame playback, pull the zoom lever toward .

Playback button ( )
Zoom lever

Arrow pad 
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Selecting the number of pictures

This function lets you select the number of pictures in an index display from 
4, 9 and 16. 

1 In the playback mode top menu,
select MODE MENU → SETUP → 

, and press .
"How to use the menus" (P.33)

2 Press  to select 4, 9 or 16, 
and press .
• Press  again to exit the menu. 

Playback button ( )

Arrow pad 

OK button
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Slideshow
This function displays still pictures stored in the card one after another. Only 
the first frame of movies are played back. 

1 Press with the lens barrier 
closed. 

2 Display a still picture, and press 
 to display the top menu.

3 Press  ( ) to start the 
slideshow. 

4 Press  to stop the slideshow. 
• The slideshow will not stop until you 

cancel it by pressing .

TIPS  
• You are recommended to use the optional AC adapter when running a 

slideshow for a long period of time. If batteries are used, the camera will 
stop the slideshow after about 30 minutes and turn off. 

Playback button ( )

Arrow pad 

OK button

MODE%MENUINFO

ERASE
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Playback on a TV

Use the AV cable provided with the camera to play back recorded images on 
your TV. Both a still picture and a movie can be played back. For a movie, the 
recorded sound is also played back along with the movie.

1 Make sure that the TV and camera are turned off. Connect 
the A/V OUT jack on the camera to the video input terminal 
on the TV using the AV cable. 

2 Turn the TV on and set it to the video input mode.
• For details of switching to video input, refer to your TV’s instruction 

manual.

3 Press . 
• The last picture taken is displayed on the TV. Use the arrow pad to 

select the picture you want to display. 
• The close-up playback, index display and slideshow functions can also 

be used on a TV screen.

TIPS  
• You are recommended to use the optional AC adapter when using the 

camera with a TV.

• Make sure that the camera’s video output signal type is the same as the 
TV’s video signal type. "VIDEO OUT - Setting the output signal 
type" (P.118)

• The camera’s monitor turns off automatically when the AV cable is 
connected to the camera. 

• Be sure to use the AV cable provided to connect the camera to the TV.
• The picture may appear off-center on the TV screen.
• When pictures are compressed in order to fit the entire picture on the TV 

screen, a black frame appears around the picture. If the picture is output 
to a video printer via the TV, the black frame may be printed. 

Connect to the TV’s video input 
(yellow) and audio input (white) 
terminals.

AV cableA/V OUT jack (MONO)

Connector cover

Note
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MOVIE PLAYBACK - Viewing movies

1 Press with the lens barrier 
closed.
• The monitor turns on. 

2 Use the arrow pad to display the 
picture with . 

"Viewing still pictures" (P.84)

3 Press . 
• The top menu is displayed. 

4 Press  to select MOVIE 
PLAYBACK.

Playback button ( )

Arrow pad 

OK button

 mark
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5 Press  to select PLAYBACK, 
and press .  
• The movie is played back. When playback 

ends, the display automatically returns to 
the beginning of the movie.

• Fast forward/fast rewind functions are 
available during playback.

: Fast forward. Each press switches 
the speed between ×1, ×2 and ×20.

: Fast rewind. Each press switches the speed between ×1, ×2 and 
×20.

• The MOVIE PLAYBACK menu is displayed again after playback ends.
PLAYBACK: Plays back the entire movie again. 
FRAME BY FRAME:

Plays back the movie manually one frame at a time. 
EXIT: Leaves the movie playback mode. 
Press  to select from PLAYBACK, FRAME BY FRAME or EXIT, 
and press . 

When FRAME BY FRAME is selected
: Displays the first frame of the movie.
: Displays the last frame of the movie.
: Displays the next frame. The movie can be played continuously 

by holding the button down.
: Displays the previous frame. The movie can be played 

continuously in reverse by holding the button down.
: Displays the MOVIE PLAYBACK menu.

TIPS  
• Movies can also be played back in the shooting mode using QUICK 

VIEW. "QUICK VIEW" (P.85)

• The access time to play a movie varies depending on the total recorded 
time and the record mode of the movie.

• The camera does not have a function to play back recorded sound. You 
need to download the movie to a PC or connect the camera to a TV to 
play back recorded sound. 

Note
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Recording sound
Sound can be added to a still picture that you have already taken. (This is known 
as “after-recording”.) You can also re-record over the sound that has already 
been recorded. Total recording time per picture is approximately 4 seconds.

1 Use the arrow pad to select the 
still picture you want to add sound 
to.

"Viewing still pictures" (P.84)

2 Press .
• The top menu is displayed.

3 In the top menu, select MODE 
MENU  PLAY  .

"How to use the menus" (P.33)

4 Press  to display START.

5 Turn the camera microphone 
toward the sound you want to 
record and press  to start 
recording.
• The BUSY bar is displayed during recording.

• To obtain the optimum sound, the microphone should be placed no 
farther than 1 m (3.3 ft.) away from the subject.

• If you re-record the sound, the original sound is erased.
• You may not be able to record sound when there is insufficient card 

memory (the “CARD FULL” message is displayed).
• Sound recording may pick up camera noises, such as button 

operation or shutter movement.
• Once sound is added to a picture, it is not possible to erase only the 

sound. In this case, make a re-recording with silence.
• The camera does not have a function to play back recorded sound. 

Playback button ( )

Arrow pad 

OK button

CA
RD
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A
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StARt
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Protecting pictures

You are recommended to protect important pictures to avoid accidentally 
erasing them. Protected pictures cannot be erased by the single-frame/all-
frame erase function.

1 Press with the lens barrier 
closed. 
• The monitor turns on. 

2 Use the arrow pad to display the 
picture you want to protect. 

"Viewing still pictures" (P.84)

3 Press . 
• The top menu is displayed. 

4 In the top menu, select MODE MENU → PLAY → , and 
press . 

"How to use the menus" (P.33)

5 Press  to select ON, and 
press . 
• To cancel protection, select OFF. 
• Press  again to exit the menu. 

• Protected pictures cannot be erased by the single-frame/all-frame erase 
functions, but they are all erased when you execute format. 

Playback button ( )

Arrow pad 

OK button

Displayed when a 
picture is protected.

Note
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Erasing pictures
This function enables you to erase recorded pictures. You can choose the 
single-frame erase or the all-frame erase.

• You cannot erase pictures that are protected. Cancel the protection 
before erasing such pictures. 

• Once erased, pictures cannot be restored. Be careful not to accidentally 
erase pictures you want to keep. "Protecting pictures" (P.95)

Single-frame erase

This function erases only the picture displayed on the monitor. The all-frame 
erase function can be used to erase all the pictures on the card at once. 

"All-frame erase" (P.97)

1 Press with the lens barrier 
closed. 
• The monitor turns on. 

2 Use the arrow pad to display the 
picture you want to erase. 

"Viewing still pictures" (P.84)

3 Press . 
• The top menu is displayed. 

4 Press  to select ERASE.

5 Press  to select YES, and 
press .
• The picture is erased and the menu is 

closed.

Note

Playback button ( )

Arrow pad 

OK button

YES

NO

SELECt GO

ERASE
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All-frame erase

This function erases all the pictures on the card. 

1 In the playback mode top menu,
select MODE MENU → CARD → 
CARD SETUP, and press .

"How to use the menus" (P.33)

2 Press  to select ALL 
ERASE, and press .

3 Press  to select YES, and 
press .
• All the pictures are erased.

Playback button ( )

Arrow pad 

OK button

CARD%SEtUP

ALL%ERASE

CANCEL GOSELECt

FORMAt

YES

CAUtION ERASING%ALL

SELECt GO

ALL%ERASE

NO
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Editing still pictures
This function lets you edit still pictures and store them as new pictures. 
The following editing operations are possible. 

BLACK&WHITE : Converts pictures into black and white pictures and stores 
them as new pictures. 

SEPIA : Converts pictures into sepia-toned pictures and stores 
them as new pictures. 

: Changes the picture size to 640 x 480 or 320 x 240 and 
stores the picture as a new picture. 

1 Press with the lens barrier 
closed. 
• The monitor turns on. 

2 Use the arrow pad to display the 
still picture you want to edit. 

"Viewing still pictures" (P.84)

3 Press . 
• The top menu is displayed. 

4 In the top menu, select MODE MENU → EDIT, and choose 
each item.

"How to use the menus" (P.33)

• Select BLACK & WHITE  (P.99)
• Select SEPIA  (P.99)
• Select  (P.100) 

Playback button ( )

Arrow pad 

OK button
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Creating black and white pictures

5 Select BLACK&WHITE, and press . 

6 Press  to select 
BLACK&WHITE, and press . 
• The BUSY bar is displayed, and the 

camera returns to the playback mode. 
The black and white picture is stored as a 
separate picture from the original. 

• To cancel the editing, select CANCEL and 
press . 

• You cannot create black and white movies. 
• You cannot create a black and white picture if there is insufficient 

memory space on the card. 

Creating sepia-toned pictures

5 Select SEPIA, and press . 

6 Press  to select SEPIA, and 
press . 
• The BUSY bar is displayed, and the 

camera returns to the playback mode. 
The sepia-toned picture is stored as a 
separate picture from the original. 

• To cancel the editing, select CANCEL and 
press .

• You cannot create sepia-toned movies. 
• You cannot create a sepia-toned picture if there is insufficient memory 

space on the card. 

BLACK%&%WHItE

CANCEL

BLACK%&%WHItE

EXIt GOSELECt

Note

SEPIA

CANCEL

SEPIA

EXIt GOSELECt

Note
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Playback
Resizing 

5 Select , and press .

6 Press  to select the new 
picture size, and press .
• The BUSY bar is displayed, and the 

camera returns to the playback mode. 
The newly created picture is stored as a 
separate picture from the original. 

• To quit the resizing function, select 
CANCEL, and press .

• Resizing is not possible in the following cases. 
Movies, pictures that have been edited on a PC, or when there is 
insufficient memory space on the card.

• If the size of the selected picture is 640 x 480, you cannot select
640 x 480. 

320*240

CANCEL

EXIt GO

640*480

SELECt

Note
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Editing movies

This function lets you create indexes as well as edit movies. However, you 
cannot edit movies of the following lengths:
Movies without sound : Longer than approximately 30 sec. in HQ mode

Longer than approximately 2 min. 30 sec. in SQ mode
Movies with sound : Longer than approximately 30 sec. in HQ mode

Longer than approximately 2 min. 10 sec. in SQ mode

INDEX 9 frames extracted from a movie are displayed as an index to show 
the movie at a glance. Indexes can be stored on the card as a still 
picture.

EDIT This function lets you erase parts of the movie that you do not want.

1 Press with the lens barrier 
closed.
• The monitor turns on. 

2 Use the arrow pad to select a 
picture with . 

3 Press . 
• The top menu is displayed. 

4 In the top menu, select MODE 
MENU → EDIT, and choose each 
item.

"How to use the menus" (P.33)

• Select INDEX  P.102
• Select EDIT  P.103

Playback button ( )

Arrow pad 

OK button
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INDEX - Creating an index

5 Select INDEX, and press .

6 Select the first frame of the index.
Press the arrow pad to play back the movie 
until the picture that you want as the first 
frame is displayed in the green frame at the 
upper left corner, and press . 

7 Select the last frame of the index.
As in Step 6, press the arrow pad to play 
back the movie until the picture that you 
want as the last frame is displayed in the 
green frame at the lower right corner, and 
press .

8 Press  to select OK, and 
press .
• The 9 frames extracted from the movie 

appear as an index display, and the 
camera returns to the playback mode. The 
index is stored as a new picture. 

• If you want to select the frames again, 
select RESET and press  and repeat 
the procedure from Step 6. 

• To cancel the index function, select CANCEL and press .

TIPS  
• The index is stored as a still picture in a different record mode from the 

original movie. 

Record mode when the movie is 
shot

Record mode when stored as 
an index

HQ 1024 x 768 pixels
SQ 640 x 480 pixels

OK

OK

GOSELECt

OK

RESEt

INDEX

CANCEL
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• The interval between the frames that are automatically picked out varies 
depending on the recording time of the movie.

• An index consists of 9 frames.
• You cannot create an index if there is insufficient memory space on the 

card. 

EDIT - Editing a movie

5 Select EDIT, and press .

6 Use the arrow pad to select the first 
frame of the part you want to keep 
and press .

: Jumps to the first frame of the movie.
: Jumps to the last frame of the movie.
: Displays the next frame. The movie can 
be played continuously by holding the 
button down.

: Displays the previous frame. The movie can be played continuously 
in reverse by holding the button down.

7 As in Step 6, use the arrow pad to 
select the last frame of the part you 
want to keep and press .

Note

OK

OK
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8 Press  to select OK, then 
press .
• If you want to select different frames, 

select RESET and press  and repeat 
the procedure from Step 6.

• To quit the editing function, select 
CANCEL and press .

9 Press  to select NEW FILE or 
OVERWRITE, then press . 
NEW FILE Stores the edited movie as 

a new movie.
OVERWRITE Stores the edited movie with 

the same name as the 
original. The original movie 
is not stored.

• The edited movie is stored and the screen returns to the playback 
mode.

• You cannot edit movies with sound which were taken with another 
digital camera.

• You cannot select NEW FILE if there is insufficient memory space 
on the card.

GOSELECt

OK

EDIt

RESEt

CANCEL

CANCEL GOSELECt

NEW FILE

OVERWRItE

EDIt

Note
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6 Useful functions
ALL RESET - Saving the camera's settings

This function lets you choose whether or not to save the current camera 
settings after the power is turned off. The settings affected by ALL RESET are 
listed on the next page. 
The ALL RESET setting (ON/OFF) applies to all the modes. If ALL RESET is 
set to OFF in one mode, this setting applies to all the other modes, both 
shooting and playback. 

ON : All settings are returned to the factory default settings after the power 
is turned off. 
For example: If you set  to SQ1 before turning off the power, this 
setting will be returned to the factory default setting, HQ, when the 
power is turned on again.

OFF : The settings made before the power is turned off are saved. 

1 In the top menu, select MODE 
MENU  → SETUP → ALL RESET → 
OFF or ON, and press .

"How to use the menus" (P.33)
• Press  again to exit the menu. 

• The functions provided on the SETUP 
tab of the mode menu ( , , 
etc.) do not return to factory default 
setting with ALL RESET. 

OK button
Arrow pad 

Note

SETUP tab
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Functions that All Reset affects and their factory default 
settings

Function Factory default setting Ref. Page
Monitor ON -
DRIVE  (for still pictures) P.68

HQ P.73
Shooting modes  (PROGRAM AUTO) P.42

AUTO P.60
OFF P.63

ESP/ ESP P.67
0.0 P.77

DIGITAL ZOOM OFF (1x) P.58
(still pictures) OFF P.81

OFF P.65
(movies) ON P.83

WB AUTO P.79
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CARD SETUP - Formatting cards
This function lets you format a card. Formatting prepares cards to receive 
data. Before using non-Olympus cards or cards which have been formatted 
on a PC, you must format them with this camera. 
All existing data, including protected pictures, are erased when the card 
is formatted. Make sure that you transfer important data to a PC before 
formatting a card in use.

1 In the top menu, select MODE 
MENU → CARD → CARD SETUP, 
and press . 

"How to use the menus" (P.33)

• Shooting mode
The  FORMAT screen is displayed.

• Playback mode
The CARD SETUP screen is displayed.

2 If the  FORMAT screen is 
displayed, press  to select 
YES. 

If the CARD SETUP screen is 
displayed, press  to select 

 FORMAT, and press . 
When the  FORMAT screen 
appears, press  to select YES. 

OK button
Arrow pad 
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3 Press .
• The BUSY bar is displayed and the card is 

formatted.

 

• Never do the following during formatting, as they may cause the card to 
malfunction. 

• Open the card cover. 
• Remove the battery. 
• Connect or disconnect the AC adapter.

YES

NO

CAUtION ERASING%ALL

SELECt GO

FORMAt

Note
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Displaying shooting information
This function lets you display detailed shooting information on the monitor for 
3 seconds in the playback mode. For details of the information displayed, see 
" "Monitor indications" (P.11)".

1 Pressing  in the playback mode 
top menu displays the full amount 
of shooting information on the 
monitor (On). 

"How to use the menus" (P.33)
• To turn INFO off, press  to bring up 

the top menu and press  (Off).

• If the picture has been taken with a different camera, only the date/time, 
file number and battery level are displayed when INFO is set to On. 

• The file number used to specify an image when making non-DPOF print 
reservations is displayed when INFO is set to ON. "With print 
reservation" (P.119)

Playback button ( )

Arrow pad 

OK button

When INFO is Off When INFO is On

Note
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Adjusting the monitor brightness
This function lets you adjust the brightness of the monitor. The brightness can 
be adjusted in either the shooting mode or the playback mode. 

1 In the top menu, select MODE 
MENU → SETUP → , and press 

.
"How to use the menus" (P.33)

2 Press  to adjust the 
brightness of the monitor, and 
when you have set the desired 
level, press .
• Pressing  brightens the monitor, and 

pressing  darkens it. 
• Press  again to exit the menu. 

OK button
Arrow pad 

ADJUSt GO
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REC VIEW 

You can choose whether or not to have the picture you have just taken displayed
briefly on the monitor. 

ON : The picture being recorded to the card is displayed. This is useful for 
making a quick check of the picture you have just taken. You can 
resume shooting anytime during REC VIEW. 

OFF : The picture being recorded to the card is not displayed. This is 
useful when you want to prepare for your next shot while the 
previous picture is being recorded. 

1 In the shooting mode top menu, 
select MODE MENU → SETUP → 
REC VIEW → OFF or ON, and press 

.
"How to use the menus" (P.33)

• Press  again to exit the menu. 

• If the batteries are running low when you take a picture with the monitor 
off and REC VIEW is set to ON, the picture may not be displayed. 

OK button
Arrow pad 

Note
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Turning off the operation and beep sound  

This function lets you turn on/off the beep sound used for warnings, etc. The 
beep sound can be adjusted in either the shooting mode or the playback 
mode. 

1 In the top menu, select MODE 
MENU → SETUP →  → OFF or 
ON, and press .

"How to use the menus" (P.33)

• Press  again to exit the menu. 

OK button
Arrow pad 
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PW ON/OFF SETUP - Power on/off display setting
You can select a picture to be displayed on the monitor when turning the 
camera on or off.  It is also possible to register your favorite picture. 
g"SCREEN SETUP" (P.114)

1 In the top menu, select MODE 
MENU  SETUP  PW ON/OFF 
SETUP, and press .

"How to use the menus" (P.33)

2 Press  to select OFF, 1 or 2, 
then press .

OFF No picture is displayed.
1 Factory default setting
2 Selects a picture already registered. If 

there is no picture registered, nothing 
is displayed when the power is turned 
on or off.

• When you have made all the settings you want, press .
Press  again to exit the menu.

OK button
Arrow pad 
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SCREEN SETUP
You can register your favorite picture to be displayed when the power is 
turned on and off. The desired picture can be registered from the card. Make 
the PW ON/OFF SETUP to display the registered picture.

"PW ON/OFF SETUP - Power on/off display setting" (P.113)

1 In the playback mode top menu, 
select MODE MENU  SETUP  
SCREEN SETUP, and press .

"How to use the menus" (P.33)

• If a picture is already registered, the 
IMAGE EXISTING screen is displayed 
asking if you want to cancel the currently 
registered picture and register a new one. 
To register a new picture, select RESET 
and press . If you select KEEP, the 
screen returns to the menu.

2 Select the picture you want to 
register using the arrow pad and press .
• You can also select the picture on the index.

"Index display" (P.88)

Arrow pad 

OK button

SELECt

SCREEN%SEtUP

IMAGE EXIStING

KEEP

RESEt
114
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3 Press  to select OK, then 
press .
• The picture is registered and the screen 

returns to the menu.
• Press  again to exit the menu.

• You cannot register pictures and movie frames that cannot be 
played back on this camera.

SELECt

SCREEN%SEtUP

SEt AS PW ON/OFF SCREEN

OK

CANCEL

Note
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FILE NAME
The camera automatically creates file names and folder names for images to 
be stored in. Files can be numbered from 0001 to 9999 and folders can be 
numbered from 100 to 999. Examples are shown below.

There are two settings from which you can choose: RESET or AUTO. Choose 
the one that is best for you when transferring images to a PC. 

File name settings
RESET : The file number and folder number are reset every time a new card 

is inserted in the camera. The folder number returns to No. 100 
and the file number returns to No. 0001. This method is useful 
when grouping files on separate cards. 

AUTO : Even if a new card is inserted, the folder number and file number 
are retained from the previous card, so the same file number is not 
used on different cards. This helps you to manage multiple cards. 
This method is useful when you want to manage all your files with 
sequential numbers. 

1 In the shooting mode top menu,
select MODE MENU → SETUP → 
FILE NAME → RESET or 
AUTO, and press .

"How to use the menus" (P.33)
• Press  again to exit the menu. 

• When the File No. reaches 9999, the file number returns to 0001 and the 
folder number changes. 

• When both the Folder and File No. reach their respective maximum 
number (999/9999), the number of storable pictures becomes 0 even if 
the card is not full. No more pictures can be taken. Replace the card with 
a new one. 

\ D C I M \ * * * O L Y M P \ P m d d * * * * . j p g

Folder No. 
(100 - 999)

File nameFolder name

Month 
(1 - C)
Day (01 - 31)

File No. 
(0001 - 9999)

• Month: Jan. - Sep. = 1 - 9, Oct. = A, Nov. = B, Dec. = C

OK button
Arrow pad 

Note
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PIXEL MAPPING
The Pixel Mapping feature allows the camera to check and adjust the CCD
and image processing functions. It is not necessary to operate this function
frequently. Approximately once a year is recommended. Wait over a minute
after the monitor is used or continuous shots are taken to allow for proper
performance of the Pixel Mapping function.

1 In the shooting mode top menu,
select MODE MENU → SETUP → 
PIXEL MAPPING, and press .

"How to use the menus" (P.33)
• START is displayed.

2 Press . 
• The BUSY bar is displayed during Pixel 

Mapping. When Pixel Mapping is finished, 
the screen returns to the mode menu. 

• If you accidentally turn the camera off during Pixel Mapping, start again 
from step 1.

OK button
Arrow pad 

Note
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VIDEO OUT - Setting the output signal type
You can select NTSC or PAL according to your TV's video signal type. Select 
the video signal type before connecting the camera to the TV. If you select 
the wrong video signal type, the recorded pictures will not be played back 
properly on your TV. Switching the video signal type between NTSC and PAL 
can be conducted in either the shooting mode or the playback mode.

1 In the top menu, select MODE 
MENU → SETUP → VIDEO OUT → 
NTSC or PAL, and press .

"How to use the menus" (P.33)

• Press  again to exit the menu. 
• The factory default setting varies 

depending on the area where you 
purchased this camera.

TIPS  
TV video signal types & main region
Check the video signal type before connecting the camera to your TV.
NTSC: Japan, Taiwan, Korea, North America
PAL: European countries, China

OK button
Arrow pad 

FILE NAME
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7 Print setting (DPOF)

With print reservation
Print reservation allows you to save printing data (the number of prints and 
the date/time information) with the pictures stored on the card.
With print reservation, you can print out pictures easily either at home using 
a personal DPOF-compatible printer or at a print shop that supports DPOF. 
DPOF is a standard format used to record automatic print information from 
digital cameras. You can print out pictures automatically, at home or in a print 
shop, by storing such data as which pictures you wish to print and the number 
of prints on a card.

Pictures taken with print reservation can be printed using the following 
procedures.

Printing using a DPOF-compatible print shop.
You can print the pictures using the print reservation data.

Printing using a DPOF-compatible printer.
Printing is possible directly from a card containing print reservation data 
without using a PC. For more details, refer to the printer's instruction manual.
A PC card adapter may also be necessary.
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TIPS  
Picture size and printing
The resolution of a computer/printer is generally based on the number of 
dots (pixels) per inch. This is called dpi (dots per inch). The higher the dpi 
value, the better the printed results. Keep in mind, however, that the dpi of 
the picture does not change. This means that when you print an image 
with a higher resolution, the size of the printed picture will be smaller. 
Although you can print magnified images, picture quality will decrease. 
If you want to print large, high-quality pictures, set the record mode as high 
as possible when taking the pictures. "Selecting a record mode" 
(P.73)

• DPOF reservations set by another device cannot be changed by this 
camera. Make changes using the original device. 

• If a card contains DPOF reservations set by another device, entering 
reservations using this camera may overwrite the previous reservations.

• The allowable number of pictures for DPOF reservation is 999 frames 
per card. 

• Print reservation may not be available if there is insufficient card 
memory. In this case, the CARD FULL message is displayed.

• Not all functions may be available on all printers or at all print shop. 
• Print reservation may take considerable time when saving printing data 

to a card. 

Note
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All-frame reservation

Use this feature to print all pictures stored on the card. Select the desired 
number of prints and whether you want the date and time included. 

1 Play back a still picture.
• You cannot print pictures with .

2 In the top menu, select MODE 
MENU → PLAY → , and press 

.
"How to use the menus" (P.33)

• If print reservation data is already stored 
on the card, the  PRINT ORDER 
SETTING screen appears, giving you the 
choice of resetting the data or keeping it.
Select KEEP and press .

3 Press  to select  (all-
frame reservation), and press .

4 Press  to select x (number 
of prints) or  (date/time), and 
press .

Playback button ( )

Arrow pad 

OK button

EXIt GOSELECt

PRINt%ORDER

 PRINT ORDER screen
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5 Perform each setting as illustrated. 

Set the number of prints
Press  to set the desired number of prints, and press .
If you want to continue to set the date/time printing data, press  to return to 
Step 4. 

: Increases the number.
: Decreases the number.

Set the date/time printing data
Press  to select NO, DATE or TIME, and press .

NO : The pictures are printed without the date and time.
DATE : All the pictures are printed with the shooting date.
TIME : All the pictures are printed with the shooting time.

• After completing all the print reservations, press  to return to the 
playback mode menu.

SEt GOSELECt

*

Select x. 

Select .

GOSELECt

*0*

GO

NO

DAtE

tIME

*

SELECt
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Single-frame reservation

Use this feature to print only selected pictures. It is also used to change the 
reserved number of prints and the date/time settings. Display the frame to be 
printed and select the desired number of prints. 

1 Play back a still picture. 
• You cannot print pictures with .

2 In the top menu, select MODE 
MENU → PLAY → , and press 

.
"How to use the menus" (P.33)

• If data is already stored on the card, the 
 PRINT ORDER SETTING screen 

appears, giving you the choice of 
resetting the data or keeping it.
Select KEEP and press .

3 Press  to select  (single-
frame reservation), and press .

4 Press the arrow pad to display the 
frame you want to print, and press 

.
• You can use the index display feature to 

select the frames. "Index display" 
(P.88)

Playback button ( )

Arrow pad 

OK button

EXIt GOSELECt

PRINt%ORDER

 PRINT ORDER screen

GOSELECt
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5 Select the appropriate item using 
the arrow pad. 
MORE : Sets the number of prints 

and date/time. → Go to 
Step 6.

SINGLE PRINT : Sets single-frame print. 
The date/time settings 
are not available. The 
print reservation is set. Return to Step 4.

CANCEL : Cancels the reservation of the picture displayed on 
the screen.  "Resetting print reservation data" 
(P.126)

END : Completes the print reservation. → Go to Step 11.

6 Press  on the arrow pad
to select x (number of prints) or 

 (date/time), and press .

7 Perform each setting.

Set the number of prints
Press  to set the desired number of prints, 
and press .

If you want to continue to set the date/time 
printing data, press  to return to Step 6. 

: Increases the number.
: Decreases the number.

MOREEND

CANCEL

SINGLE PRINt
124



Single-frame reservation
7

Print setting (D
PO

F)

Set the date/time printing data
Press  to select NO, DATE or
TIME, and press .

NO : The pictures are printed without the 
date and time.

DATE : All the pictures with print reservation 
are printed with the shooting date.

TIME : All the pictures with print reservation 
are printed with the shooting time.

8 After setting the number of prints and the date/time 
printing data, press  again to complete the print 
reservations, and return to the screen in Step 4.
•  mark is displayed on the image displayed on the screen.

9 Press  to display the single-
frame reservation menu.

10  Press  to select END.
• The  PRINT ORDER screen appears. 
• Press  again to display the  PRINT 

ORDER SETTING screen, and press  
once more to return to the playback mode 
menu.

11 Press  to return to the mode 
menu.
• Press  to close the menu.

GOSELECt

 

 Mark

MOREEND

CANCEL

SINGLE PRINt

Single-frame reservation 
menu screen
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Resetting print reservation data
This function allows you to reset the print reservation data for the pictures 
stored on the card.
There are two ways to reset the print reservation data. One is to reset the print 
reservation data for all the frames. The other is to reset the print reservation 
data for the unwanted frames only.

1 Play back the still picture marked 
.

2 In the top menu, select MODE 
MENU → PLAY → , and press 

. 
"How to use the menus" (P.33)

• The  PRINT ORDER SETTING 
screen appears. 

3 When resetting the print 
reservation data for all the 
frames, press  to select 
RESET, and press .
To reset the print reservation 
data for the unwanted frame 
only, press  to select KEEP, 
and press .

4  PRINT ORDER SETTING screen is displayed. Press 
 to select SINGLE PRINT, and press .

5 Use the arrow pad to display the 
frame that has the print reservation 
data you want to reset, and press 

.
• The Single-frame reservation menu 

screen appears.

Playback button ( )

Arrow pad 

OK button

RESEt

KEEP

PRINt%ORDER%SEttING

PRINt%ORDERED

SELECtEXIt GO

 PRINT ORDER 
SETTING screen

GOSELECt
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6 Press  to select CANCEL.
• The selected print reservation data is 

canceled and the camera returns to the 
screen in Step 5.

7 When there are not any other print reservation data to be 
reset, press  to display the Single-frame reservation  
menu screen, and press .

8 Press  to return to the mode menu.
• Press  to close the menu.

MOREEND

CANCEL

SINGLE PRINt

Single-frame reservation 
menu screen
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8 Direct printing (PictBridge)
Using the direct printing function

By connecting the camera to a PictBridge-compatible printer with the USB 
cable, you can print out recorded pictures directly without the use of a 
computer. With the camera connected to the printer, use the camera’s 
monitor to select the pictures you want to print, and the number of prints you 
want to make. It is also possible to print out pictures using the print 
reservation data.  "Print setting (DPOF)" (P.119)
To find out if your printer is compatible with PictBridge, refer to the printer’s 
instruction manual.

What is PictBridge? … It is the standard for connecting digital cameras and 
printers of different makers and printing out pictures directly.

STANDARD … All printers that support PictBridge have standard print 
settings. Selecting  STANDARD on the settings screens (  P.132 to 
139), images are printed according to the default settings. See the instruction 
manual for your printer for its standard settings or inquire with the printer 
manufacturers.

TIPS
• For details of printing paper types, ink cassettes, etc., refer to the 

printer’s instruction manual.

• You are recommended to use the optional AC adapter for the camera 
when printing pictures directly. If you use the battery, make sure that it 
is fully charged. If the camera stops operating while communicating with 
the printer, the printer may malfunction or image data may be lost.

• Images recorded in movies cannot be printed.
• The camera will not enter sleep mode when connected to the USB 

cable.

Note
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Connecting the camera to a printer

Use the USB cable provided with the camera to connect the camera to a 
PictBridge-compatible printer.

1 Turn the printer on and plug the 
printer end of the USB cable into 
the printer’s USB port.
• For details of how to turn the printer on and 

the position of the USB port, refer to the 
printer’s instruction manual.

2 Plug the other end of the USB cable 
into the camera’s USB connector.
• The camera turns on automatically.
• The monitor turns on and the selection 

screen for the USB connection is 
displayed.

3 Press  to select PRINT, then 
press . 
• ONE MOMENT is displayed and the 

camera and printer are connected. The 
PRINT MODE SELECT screen is 
displayed on the monitor. Make the print 
settings on the camera’s monitor.   Go 
to "Printing pictures" (P.130).

• If PC is selected in step 3, the PRINT MODE SELECT screen is not 
displayed. If the screen is not displayed after several minutes, remove 
the USB cable from the camera and start again from step1.

USB connector

GOSELECt

Note
129



8
D

irect printing (PictB
ridge)
Printing pictures
When the camera is connected to a PictBridge-
compatible printer, the PRINT MODE SELECT 
screen is displayed on the monitor. Use this 
screen to select the print mode. You can choose 
from the following print modes.

PRINT Prints the selected picture.
"PRINT mode/MULTI PRINT mode" (P.132)

ALL PRINT Prints all the pictures stored on the card.
"ALL PRINT mode" (P.136)

MULTI PRINT Prints one picture in multiple layout format.
"PRINT mode/MULTI PRINT mode" (P.132)

ALL INDEX Prints an index of all the pictures stored on the card.
"ALL INDEX mode/PRINT ORDER mode" (P.138)

PRINT ORDER Prints the pictures according to the print reservation data 
on the card. If no print reservations (  P.119) have been 
made, this option is not available. 

"ALL INDEX mode/PRINT ORDER mode" (P.138)

 

GOSELECtEXIt

• Available options for some settings such as the print mode and paper 
size may differ depending on the type of printer. For details, refer to 
the instruction manual of your printer.

Options for the print mode and other settings
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Using the simple print method

The following is the simplest way of printing a picture. This prints one copy of 
the selected picture. The date or file name will not be printed.

1 In the PRINT MODE SELECT 
screen, press  to select 
PRINT or MULTI PRINT, then press 

.
• The PRINT PAPER screen is displayed.

2 Press  to select the paper 
size, then press .
• When the PRINT PAPER screen is not 

displayed, SIZE, BORDERLESS and 
PICS/SHEET are set to  STANDARD. 
Go to step 4.

3 Use  to select framed or 
unframed, then press .
OFF ( ) The image is printed 

inside a blank frame.
ON ( ) The image is printed filling 

the entire page.

4 Press  to select the picture you 
want to print, and press .
• The PRINT screen is displayed. 

Arrow pad 
OK button

PRINt PAPER

SIZE BORDERLESS

CANCEL GOSELECt

StANDARDStANDARD

PRINt PAPER

SIZE BORDERLESS

StANDARDStANDARD

GOSELECt
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5 Press  to select PRINT, then 
press .
• Printing starts. 
• To cancel printing, select CANCEL and 

press . The PRINT MODE SELECT 
screen will be displayed again.

• When printing completes, the monitor 
displays the PRINT PAPER screen shown 
in Step 4. If you want to continue printing, repeat step 4 and 5. 

PRINT mode/MULTI PRINT mode

1 In the PRINT MODE SELECT 
screen, press  to select 
PRINT or MULTI PRINT, then press 

.
• The PRINT PAPER screen is displayed.

2 Press  to select the paper 
size, then press .
• PRINT mode: Go to step 3.
• MULTI PRINT mode:Go to step 4.
• When the PRINT PAPER screen is not 

displayed, SIZE, BORDERLESS and 
PICS/SHEET are set to  STANDARD. 
Go to step 5.

CANCEL GOSELECt

PRINt

OK

CANCEL

Arrow pad 

OK button

Zoom lever

PRINt PAPER

SIZE BORDERLESS

CANCEL GOSELECt

StANDARDStANDARD

PRINT PAPER screen
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3 Use  to select framed or 
unframed, then press .
Go to step 5.

OFF ( ) The image is printed 
inside a blank frame.

ON ( ) The image is printed filling 
the entire page.

4 Press  to select PICS/SHEET, 
then press .
• PICS/SHEET depends on the paper size 

set in step 2 and the capabilities of your 
printer.

5 Press  to select the picture you 
want to print.
• Press the zoom lever toward W to display 

the pictures in index format. You can then 
select the pictures you want to print from 
the index.

6 Select the print reservation method
SINGLE PRINT Makes a single-frame print reservation for the selected 

picture according to standard settings.
MORE Sets the number of prints of the selected picture in the 

print reservation data. You can also add the date or file 
name.

PRINt PAPER

SIZE BORDERLESS

StANDARDStANDARD

GOSELECt
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Set a SINGLE PRINT reservation
Press .
• Press  when  is displayed to cancel 

the reservation.

Set MORE print reservations
Press .
• Print information setting screen is displayed.

Press  to select the item 
you want to set, then press .
• Press  to select the item, then 

press .

 × Sets the number of prints. You can select up 
to 10 prints.

DATE ( ) If you select WITH, pictures are printed with 
the date and time.

FILE NAME ( ) If you select WITH, pictures are printed with 
the file name.

• DATE and FILE NAME are not available in MULTI PRINT mode.

SELECt PRINt
CANCEL MORE

Print reservation 
mark is displayed.

GOSELECt SEt

1X

FILE NAME WItHOUtWItHOUt

WItHOUtWItHOUt
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When you have finished all the settings for MORE, 
press .
• The screen displayed in Step 5 appears.

• To print more than one picture in PRINT 
and/or MULTI PRINT mode, repeat 
Steps 5 and 6 and make single and/or 
multiple print reservations for all the 
pictures you want to print.

•  is displayed in MULTI PRINT mode.

7 Press .
• The PRINT screen is displayed.

8 Print the pictures.
• Press  to select OK or CANCEL, 

then press .

OK Printing starts.
CANCEL The settings are canceled and 

the monitor returns to the 
PRINT MODE SELECT screen.

• When printing is finished, the monitor 
returns to the PRINT MODE SELECT 
screen.

"Exiting direct printing" (P.140)

To cancel printing
Pressing  during print data transfer displays 
the screen for selecting whether to continue or 
cancel printing. To cancel printing, press  
to select CANCEL, then press .

SELECt PRINt
CANCEL MORE

The settings you have 
made are displayed. 

CANCEL GOSELECt

PRINt

OK

CANCEL

TRANSFERRING screen

GO

PRINt

CONtINUE

CANCEL

SELECt
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ALL PRINT mode

1 In the PRINT MODE SELECT 
screen, press  to select ALL 
PRINT, then press .
• The PRINT PAPER screen is displayed.

2 Press  to select the paper 
size, then press .
• When the PRINT PAPER screen is not 

displayed, SIZE and BORDERLESS are 
set to  STANDARD. Go to Step 4.

3 Use  to select framed or 
unframed, then press .

OFF ( ) The image is printed inside a 
blank frame.

ON ( ) The image is printed filling the 
entire page.

• Print information setting screen is 
displayed.

4 Press  to select the item you 
want to set, then press .
• Press  to select the item, then press 

.
• If PRINT INFO cannot be set with your 

printer, go to step 6.
• Only one print of each image can be made 

at a time.

GOSELECtEXIt

PRINt PAPER

SIZE BORDERLESS

CANCEL GOSELECt

StANDARDStANDARD

PRINt PAPER

SIZE BORDERLESS

StANDARDStANDARD

GOSELECt

GOSELECt SEt

1X

FILE NAME

WItHOUtWItHOUt

WItHOUtWItHOUt
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DATE ( ) If you select WITH, pictures are printed with the 
date and time.

FILE NAME ( ) If you select WITH, pictures are printed with the 
file name.

5 Press .
• The PRINT screen is displayed.

6 Print the pictures.
• Press  to select OK or CANCEL, 

then press .

OK Printing starts.
CANCEL The settings are canceled and 

the monitor returns to the 
PRINT MODE SELECT screen.

• When printing is finished, the monitor 
returns to the PRINT MODE SELECT 
screen.

"Exiting direct printing" (P.140)

To cancel printing
Pressing  during print data transfer displays 
the screen for selecting whether to continue or 
cancel printing. To cancel printing, press  
to select CANCEL, then press .

CANCEL GOSELECt

PRINt

OK

CANCEL

TRANSFERRING screen

GO

PRINt

CONtINUE

CANCEL

SELECt
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ALL INDEX mode/PRINT ORDER mode

1 In the PRINT MODE SELECT 
screen, press  to select ALL 
INDEX or PRINT ORDER, then 
press .
• The PRINT PAPER screen is displayed.

2 Press  to select the paper 
size, then press .
• When the PRINT PAPER screen is not 

displayed, SIZE and BORDERLESS are 
set to  STANDARD. Go to Step 4.

3 Use  to select framed or 
unframed, then press .

OFF ( ) The image is printed inside a 
blank frame.

ON ( ) The image is printed filling the 
entire page.

• The print screen is displayed.
• BORDERLESS is not available in ALL INDEX mode.

Press  and go to Step 4.

GOSELECtEXIt

PRINt PAPER

SIZE BORDERLESS

CANCEL GOSELECt

StANDARDStANDARD

PRINt PAPER

SIZE BORDERLESS

StANDARDStANDARD

GOSELECt
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4 Print the pictures.
• Press  to select OK or CANCEL, 

then press .

OK Printing starts.
CANCEL The settings are canceled and 

the monitor returns to the 
PRINT MODE SELECT screen.

• When printing is finished, the monitor 
returns to the PRINT MODE SELECT 
screen.

"Exiting direct printing" (P.140)

To cancel printing
Pressing  during print data transfer displays 
the screen for selecting whether to continue or 
cancel printing. To cancel printing, press  
to select CANCEL, then press .

CANCEL GOSELECt

PRINt

OK

CANCEL

TRANSFERRING screen

GO

PRINt

CONtINUE

CANCEL

SELECt
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Exiting direct printing
When you have finished printing, disconnect the camera from the printer.

1 In the PRINT MODE SELECT screen, 
select .

• The message is displayed.

2 Remove the USB cable from the 
camera.
• The camera turns off.

3 Remove the USB cable from the 
printer.

GOSELECtEXIt
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If an error code is displayed

If an error code appears on the camera’s monitor during direct print setting or 
printing, see the following table.
For more details, refer to the printer’s instruction manual.

TIPS
• If an error code other than those shown above is displayed, refer to

  "Error codes" (P.142).

Monitor indication Possible cause Corrective action

NO CONNECTION

The camera is not 
connected to the printer 
correctly.

Disconnect the camera 
and connect it again 
correctly.

NO PAPER

There is no paper in the 
printer.

Load some paper in the 
printer.

NO INK

The printer has run out of 
ink.

Replace the ink cartridge 
in the printer.

JAMMED

The paper is jammed. Remove the jammed 
paper.

SETTINGSS CHANGED

The printer’s paper 
cassette has been 
removed or the printer 
has been manipulated 
while making settings on 
the camera.

Do not manipulate the 
printer while making 
settings on the camera.

PRINT ERROR

There is a problem with 
the printer and/or 
camera.

Turn off the camera and 
printer. Check the printer 
and remedy any 
problems before turning 
the power on again.
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Error codes
Monitor 
indication

Possible cause Corrective action

NO CARD

The card is not inserted, 
or it cannot be recognized.

Insert a card or insert a different card.
If the problem persists, format the card. 
If the card cannot be formatted, it 
cannot be used.

CARD ERROR

There is a problem with the 
card.

This card cannot be used. Insert a new 
card.

WRITE-
PROTECT

Writing to the card is 
prohibited.

Read-only setting is applied to the card 
by a PC. Cancel the setting using the 
PC.

CARD FULL

The card is full. No more 
pictures can be taken or no 
more information such as 
print reservation can be 
recorded. 

Replace the card or erase unwanted 
pictures. Before erasing, download 
important images to a PC. 

NO PICTURE

There are no pictures on 
the card. 

The card contains no pictures. Record 
pictures. 

PICTURE 
ERROR

The selected picture has a 
problem, therefore it 
cannot be played back on 
this camera.

Use image processing software to view 
the picture on a PC. If that cannot be 
done, the image file is damaged. 

CARD-COVER 
OPEN

The card cover is open. Close the card cover.

The card is not formatted. Format the card.
All data on the card is deleted.

POWER%OFF

FORMAt

CARD%SEtUP

SELECt GO
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Troubleshooting

The camera does not work

The camera does not turn on or function buttons do not respond.
Possible cause Corrective action Ref. Page

The power is off. Open the lens barrier fully to turn on the camera. P.23

The batteries are 
loaded incorrectly.

Reload the batteries correctly. P.16

The batteries are 
exhausted.

Replace the batteries with new ones. P.16

The batteries are 
temporarily unable to 
function because of 
the cold.

Warm the batteries by putting them in your 
pocket for a while.

–

The camera is in the 
sleep mode.

Operate the camera (press the shutter button or 
the zoom lever etc.).

P.24

There is condensation* 
inside the camera.

Wait until the camera dries before turning it on 
again.

–

The camera is 
connected to a PC.

Disconnect from PC. The camera will not 
operate while it is connected to a PC.

–

*Condensation: When it is cold outside, the water vapor in the air is rapidly cooled and 
turns to droplets of water.
Condensation occurs when the camera is suddenly taken from a cold 
place into a warm room.

No picture is taken when the shutter button is pressed.

Possible cause Corrective action Ref. Page

The lens barrier is 
closed.

Open the lens barrier fully. P.44

The power is off. Open the lens barrier fully. P.23

The flash has not 
finished charging.

Release your finger from the shutter button, and 
wait until the orange lamp stops blinking. Press 
the shutter button again. 

P.60

The movie just taken is 
being written to the 
card.

Release your finger from the shutter button. 
When the orange lamp stops blinking, resume 
shooting. 

P.55

The card is full. Erase unwanted picture or insert a new card. 
Before erasing, download important images to a 
PC. 

P.96, P.97, 
P.107

The memory gauge is 
full. 

Wait until there is room in the memory gauge. P.13
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There is a problem 
with the card.

Refer to the "Error codes". P.142

The flash does not fire.

Possible cause Corrective action Ref. Page

The flash is set to the 
flash off mode.

Select a flash mode other than flash off. P.60

The subject is 
illuminated.

If you want the flash to fire on a brightly 
illuminated subject, set the flash to fill-in mode.

P.60

Sequential shooting, 
movie mode, or super 
macro shooting is set.

The flash does not fire in the sequential 
shooting, movie mode or super macro shooting. 
Set  in the DRIVE mode.

P.68

Panorama mode is set. The flash does not fire in the panorama mode. 
Cancel the panorama mode.

P.69

The green and orange lamps on the right of the viewfinder blink simultaneously.

Possible cause Corrective action Ref. Page

The batteries are 
exhausted.

Replace the batteries with new ones. P.16

The monitor does not turn on. 

Possible cause Corrective action Ref. Page
The camera is in the 
sleep mode.

Operate the camera (press the shutter button or 
the zoom lever etc.).

P.24
144



Troubleshooting
9

M
iscellaneous

The monitor is hard to see.
Possible cause Corrective action Ref. Page

The brightness is not 
adjusted properly.

Select  in the mode menu and then adjust 
the brightness.

P.110

The monitor is 
exposed to direct 
sunlight.

Block the sunlight with your hand. –

Vertical lines appear 
on the monitor screen.

Bright light, such as direct sunlight, may cause 
vertical lines to appear on the monitor screen. 
This is not a malfunction.

–

Pictures you have taken do not appear on the monitor.
Possible cause Corrective action Ref. Page

The power is off. Close the lens barrier, and press  to turn the 
monitor on.

P.24, P.84

The camera is in the 
shooting mode.

Press  or close the lens barrier and then 
press  to switch to the playback mode.

P.24, P.85

There are no pictures 
on the card.

NO PICTURE appears on the monitor. Record 
pictures. 

–

There is a problem 
with the card.

Refer to the "Error codes". P.142

The camera is 
connected to a TV.

The monitor does not function when the AV 
cable is connected to the camera.

P.91

The date recorded with the image data is wrong.

Possible cause Corrective action Ref. Page
The date/time is not 
set.

Set the date/time. The clock adjustment is not 
factory-preset.

P.29

The camera has been 
left with the batteries 
removed.

If the camera is left for about 3 days with the 
batteries removed, the date and time setting will 
revert to the factory default setting. Set the date/
time again.

P.17, P.29
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The settings are returned to the factory default settings when the camera is turned off. 
Possible cause Corrective action Ref. Page

ALL RESET is set to 
ON. 

Select the SETUP tab in the mode menu and set 
ALL RESET to OFF. 

P.105

No picture is displayed on the TV when connected to the camera.

Possible cause Corrective action Ref. Page

The video output 
signal is incorrect.

Set the video output signal according to the 
region where used.

P.118

The camera is not in 
the playback mode.

Press  or close the lens barrier and then 
press  to switch to the playback mode.

P.24, P.85

The TV video signal 
setting is incorrect.

Set the TV to the video input mode. P.91
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The image quality is poor

The picture is too bright.
Possible cause Corrective action Ref. Page

The flash was set to the 
fill-in flash mode.

Select a flash mode other than fill-in flash. P.60

The subject was 
excessively illuminated.

Adjust the exposure compensation toward 
minus (-) or change the camera position.

P.77

The picture is too dark.

Possible cause Corrective action Ref. Page
The flash was blocked 
by your finger.

Hold the camera correctly, keeping your 
fingers away from the flash.

P.31

The subject was out of 
the working range of the 
flash. 

Shoot within the flash working range. P.60

The flash was set to the 
flash off mode.

Select a flash mode other than flash off. P.60

The subject was too 
small and was backlit.

Set the flash to fill-in mode, or use the spot 
metering mode.

P.60, P.67

The sequential shooting 
mode was used.

Higher shutter speeds are used when the 
sequential shooting mode is selected, which 
may result in pictures that are darker than 
usual. Select  in the DRIVE menu.

P.68

Bright subjects such as 
snow will turn out darker 
than their natural colors 
in the image.

Adjust the exposure compensation toward +. P.77

The colors of pictures taken indoors look unnatural.

Possible cause Corrective action Ref. Page

Indoor lighting can affect 
the picture's colors.

Set the white balance according to the lighting. P.79

There is no white in the 
subject.

Include something white in the picture, or 
shoot using the fill-in flash mode.

P.60

The white balance 
setting is wrong.

Adjust the white balance according to the light 
source.

P.79
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The picture has obscured edge(s).

Possible cause Corrective action Ref. Page
The lens was partly 
blocked by your finger or 
the strap.

Hold the camera correctly, keeping your 
fingers and the strap away from the lens.

P.31

The subject was too 
close.

Check the actual picture area by using the 
monitor to take the picture.

P.44

The picture is out of focus.

Possible cause Corrective action Ref. Page

The camera moved 
when the shutter button 
was pressed.

Hold the camera correctly and press the 
shutter button gently. 
Camera movement occurs easily with slower 
shutter speeds. When you take a picture with 
the flash off mode in a night scene or a dark 
situation, use a tripod, or hold the camera 
firmly. 

P.31
P.60

The lens was dirty. Clean the lens. Use a commercially available 
blower blush and then wipe with a Lens 
cleaner to remove dust. Mold may form on the 
lens surface if the lens is left dirty.

–

The focus may not be 
correct even if the green 
lamp lights.

Determine the position of the subject after 
focusing the camera on an object about the 
same distance away as the subject.

P.50
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The life of the batteries is short.
Possible cause Corrective action Ref. Page

The camera is being 
used in a cold area.

The battery performance decreases in cold 
areas. Protect the camera from the cold by 
using a cold protection gear, or by putting it 
inside your clothes.

–

The correct battery level 
is not displayed.

Batteries can run out without a warning 
message when the amount of power 
consumed increases considerably. Replace 
with new batteries.

P.16

The printer fails to connect.

Possible cause Corrective action Ref. Page
PC was selected on the 
monitor after connecting 
to the printer with a USB 
cable.

Turn the camera off and start again from step 
1 of “Connecting the camera to a printer”.

P.129

The printer does not 
support PictBridge.

Refer to the printer’s instruction manual or 
contact the manufacturer.

–
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List of menus
Shooting mode menus (  /  /  /  /  / )

*1 Cannot be selected in  mode.
*2 Cannot be selected in  mode.

Top menu Tab Function Setting Ref. 
Page

MODE 
MENU

CAMERA ESP/ ESP, P.67

-2.0, -1.5, -1.0, 
-0.5, 0, +0.5, 
+1.0, +1.5, +2.0

P.77

DIGITAL ZOOM*1 ON, OFF P.58
(still pictures) ON, OFF P.81

ON, OFF P.65
PANORAMA*1 P.69
2 IN 1*2 P.71

PICTURE WB AUTO, , , 
, 

P.79

CARD CARD SETUP YES, NO P.107
SETUP ALL RESET ON, OFF P.105

ENGLISH, FRANCAIS, 
DEUTSCH, ESPAÑOL, 
ITALIANO, РУССКИЙ, 
PORTUGUES

P.27

PW ON/OFF SETUP OFF, 1, 2 P.113
ON, OFF P.112

REC VIEW ON, OFF P.111
FILE NAME RESET, AUTO P.116
PIXEL MAPPING P.117

P.110
P.29

VIDEO OUT NTSC, PAL P.118
DRIVE , P.68

SHQ, HQ, SQ1, 
SQ2

P.73

MONITOR OFF (MONITOR ON) P.49
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Shooting mode menus ( )
Top menu Tab Function Setting Ref. 

Page
MODE 
MENU

CAMERA ESP/ ESP, P.67

-2.0, -1.5, -1.0, 
-0.5, 0, +0.5, 
+1.0, +1.5, +2.0

P.77

DIGITAL ZOOM ON, OFF P.58
ON, OFF P.65

PICTURE WB AUTO, , , 
, 

P.79

CARD CARD SETUP YES, NO P.107
SETUP ALL RESET ON, OFF P.105

ENGLISH, FRANCAIS, 
DEUTSCH, ESPAÑOL, 
ITALIANO, РУССКИЙ, 
PORTUGUES

P.27

PW ON/OFF SETUP OFF, 1, 2 P.113
ON, OFF P.112

REC VIEW ON, OFF P.111
FILE NAME RESET, AUTO P.116
PIXEL MAPPING P.117

P.110
P.29

VIDEO OUT NTSC, PAL P.118
ON, OFF P.83
HQ, SQ P.73

MONITOR OFF (MONITOR ON) P.49
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Playback mode menus (Still picture)

 

Top menu Tab Function Setting Ref. 
Page

MODE 
MENU

PLAY ON, OFF P.95

0°, +90°, -90 P.87

 , P.123, 
P.121

START P.94
EDIT BLACK & WHITE BLACK & WHITE, 

CANCEL
P.99

SEPIA SEPIA, CANCEL P.99
640x480, 
320x240, 
CANCEL

P.100

CARD CARD SETUP ALL ERASE,
 FORMAT

P.97,
 P.107

SETUP ALL RESET ON, OFF P.105
ENGLISH, FRANCAIS, 
DEUTSCH, ESPAÑOL, 
ITALIANO, РУССКИЙ, 
PORTUGUES

P.27

PW ON/OFF SETUP OFF, 1, 2 P.113
SCREEN SETUP P.114

ON, OFF P.112
P.110
P.29

VIDEO OUT NTSC, PAL P.118
 4, 9, 16 P.89

P.90
INFO P.109

ERASE YES, NO P.96
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Playback mode menus ( )
Top menu Tab Function Setting Ref. 

Page
MODE 
MENU

PLAY ON, OFF P.95
EDIT INDEX OK, RESET, 

CANCEL
P.102

EDIT OK, RESET, 
CANCEL

P.103

CARD CARD SETUP ALL ERASE,
 FORMAT

P.97,
 P.107

SETUP ALL RESET ON, OFF P.105
ENGLISH, FRANCAIS, 
DEUTSCH, ESPAÑOL, 
ITALIANO, РУССКИЙ, 
PORTUGUES

P.27

PW ON/OFF SETUP OFF, 1, 2 P.113
ON, OFF P.112

P.110
P.29

VIDEO OUT NTSC, PAL P.118
 4, 9, 16 P.89

MOVIE 
PLAYBACK

PLAYBACK, 
FRAME BY 
FRAME, EXIT

P.92

INFO P.109
ERASE YES, NO P.96
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List of factory default settings
Shooting mode

Playback mode

Other default settings

* Setting differ according to the region where the camera is sold.

 AUTO
OFF
OFF

Shooting mode  (PROGRAM AUTO)
Zoom Wide
Monitor ON
ESP/ ESP

HQ
0.0

DRIVE  (Single-frame shooting)
DIGITAL ZOOM OFF
PANORAMA OFF
2 IN 1 OFF
WB AUTO
FILE NAME RESET

OFF
(movies) ON
(still pictures) OFF

OFF
OFF

INFO OFF
OFF
0°
9

ALL RESET ON
ENGLISH
ON

REC VIEW ON
±0
2004.01.01

VIDEO OUT
PW ON/OFF SETUP 1
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List of items by shooting mode

* In the movie record mode, only HQ/SQ can be selected.

Shooting mode

Item
K

% —

—

Optical zoom W (Wide) 
fixed

ESP/

*

— —

DIGITAL ZOOM —

PANORAMA — —

2 IN 1 — —
WB

R(Still pictures) — — — — — —

R(Movies) —
CARD SETUP

ALL RESET

REC VIEW

FILE NAME

PW ON/OFF SETUP
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Camera maintenance
After use

Turn the camera off.
Cleaning the camera

1 Close the lens barrier to turn the camera off. 
Make sure that the monitor is turned off. 

2 Remove the batteries ( P.16). (If you are using an AC 
adapter, unplug the AC adapter from the camera first 
before removing the plug from the AC outlet.)

3 Exterior:
→ Wipe gently with a soft cloth. If the camera is very dirty, soak the cloth 

in mild soapy water and wring well. Wipe the camera with the damp 
cloth and then dry it with a dry cloth. If you have used the camera at 
the beach, use a cloth soaked in clean water and well wrung.

Monitor and viewfinder:
→ Wipe gently with a soft cloth.
Lens:
→ Blow dust off the lens with a commercially available blower, and wipe 

gently with a commercially available lens cleaning paper. 
Card: 
→ Wipe gently with a soft, dry cloth.

Storage
• When storing the camera for extended periods, remove the batteries and 

card from the camera, and keep it in a cool, dry place that is ventilated 
well.

• Periodically, replace the batteries, and test camera functions.

• Do not use strong solvents such as benzene or alcohol, or chemically 
treated cloth.

• Cleaning should be done only after the batteries have been removed or 
the AC adapter has been disconnected. 

• Mold may form on the lens surface if the lens is left dirty.
• Avoid leaving the camera in places where chemical products are 

handled since this may result in corrosion.

Note
156



9

M
iscellaneous

Specifications
Product type : Digital camera (for shooting and displaying)
Recording system

Still picture : Digital recording, JPEG (in accordance with 
Design rule for Camera File system (DCF))

Applicable
standards

: Exif 2.2, Digital Print Order Format (DPOF), 
PRINT Image Matching II, PictBridge

Movie : QuickTime Motion JPEG support
Memory : xD-Picture Card (16 – 512 MB)
No. of storable pictures
When a 16 MB card
is used

: Approx. 5 frames (SHQ : 2288 x 1712)
Approx. 16 frames (HQ : 2288 x 1712)
Approx. 32 frames (SQ1 : 1600 x 1200)
Approx. 165 frames (SQ2 : 640 x 480)

No. of effective pixels : 4,000,000 pixels
Image pickup device : 1/2.5" CCD solid-state image pickup, 4,230,000 

pixels (gross)
Lens : Olympus lens 5.8 to 17.4 mm, f3.1 to 5.2, 

5 elements in 3 groups
(equivalent to 35 mm to 105 mm lens on 35 mm 
camera)

Photometric system : Digital ESP metering, spot metering
Shutter speed : 1 to 1/1000 sec. (2 sec. For the NIGHT SCENE 

mode)
Shooting range : 50 cm (1.6 ft.) to  (normal)

20 cm to 50 cm (0.7 ft. to 1.6 ft.) (macro mode)
Viewfinder : Optical real image viewfinder
Monitor : 1.8" TFT color LCD display, 85,000 pixels
Outer connector : DC-IN jack, USB connector (mini-B), A/V OUT 

jack (MONO)
Automatic calendar 
system

: 2000 up to 2099
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Operating environment
Temperature : 0°C to 40°C (32°F to 104°F) (operation) 

-20°C to 60°C (-4°F to 140°F) (storage)
Humidity : 30% to 90% (operation)/10% to 90% (storage)

Power supply : 1 CR-V3 lithium battery pack, or 2 AA (R6) 
alkaline batteries or NiMH batteries.
AC adapter (optional)

Manganese (zinc-carbon) batteries cannot be 
used.

Dimensions : 108 mm (W) x 57.5 mm (H) x 36.5 mm (D) 
(4.2" x 2.2" x 1.4")
(excluding protrusions)

Weight : 165 g (0.4 lb) (without batteries or card)

SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT ANY NOTICE 
OR OBLIGATION ON THE PART OF THE MANUFACTURER.
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Glossary of terms
CCD (Charge-Coupled Device)
This converts light passing through the lens into electrical signals. On this 
camera, light is picked up and converted into RGB signals to build a single 
image. 

DCF (Design rule for Camera File system)
A standard for image files by the Japan Electronics and Information 
Technology Industries Association (JEITA).

Digital ESP (Electro-Selective Pattern) Light Metering
This determines the exposure by metering and calculating the light levels in 
the center and other areas of the image separately.

DPOF (Digital Print Order Format)
This is for saving desired print settings on digital cameras. By entering which 
images to print and the number of copies of each, the user can easily have 
the desired images printed by a printer or print lab that supports the DPOF 
format.

Exposure
The amount of light used to capture an image. The exposure is determined
by the time the shutter is open (shutter speed) and the amount of light that
passes through the lens (aperture).

JPEG (Joint Photographic Experts Group)
A compression format for color still images. Photographs (images) shot using 
this camera are recorded onto the card in JPEG format when the Record 
mode is set to SHQ, HQ or SQ. By downloading these images to a personal 
computer, users can edit them using graphics application software or view the 
images using an Internet web browser.

NTSC (National Television Systems Committee) / PAL (Phase
Alternating Line)
Television formats. NTSC is mainly used in Japan, North America and Korea. 
PAL is mainly used in Europe and China.

PictBridge
It is the standard for connecting digital cameras and printers of different 
makers and printing out pictures directly.

Pixels
A pixel is the smallest unit (dot) used to make up an image. Clear large-sized 
printed images require millions of pixels. 
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Resolution
The size of the picture expressed as the number of dots (pixels) that make up 
the image. For instance, a picture taken in 640 x 480 resolution is the same 
size as the PC screen when the monitor setting is 640 x 480. However, if the 
monitor setting is 1024 x 768, the picture only takes up part of the screen. 

Sleep Mode
A mode designed to save battery life. The camera automatically enters the 
sleep mode if you do not operate it for a certain time. To get out of the sleep 
mode, use any button on the camera (shutter button, arrow pad, etc.).

TFT (Thin-Film Transistor) Color Monitor
A color monitor constructed using thin-film transistor technology. 
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Index
A
A/V OUT jack (MONO)  . . . . . . 9,91
AC adapter  . . . . . . . . . . . . . . . . . 18
Adjusting the monitor brightness

. . . . . . . . . . . . . . . . . . 110
AF target mark. . . . . . .10,11,46,50
Alkaline batteries . . . . . . . . . . . . . 18
ALL RESET . . . . . . . . . . . . . . . . 105
All-frame erase  . . . . . . . . . . 97
All-frame reservation . . . . . 121
Arrow pad  . . . . . . . . . . . . . . . 10,84
Auto focus . . . . . . . . . . . . . . . . . . 52
Auto-flash  . . . . . . . . . . . . . . . . . . 61
AV cable  . . . . . . . . . . . . . . . . . . . 91

B
Batteries  . . . . . . . . . . . . . . . . . . . 16
Battery check. . . . . . . . . . . . . . . . 13
Battery compartment cover . . 10,16
Beep sound . . . . . . . . . . . . 112

C
Camera movement warning  . . . . 11
Card. . . . . . . . . . . . . . . . . . . . . . . 20
Card check  . . . . . . . . . . . . . . . . . 26
Card cover. . . . . . . . . . . . . . . . 9,21
CARD SETUP . . . . . . . . . . . 107
Close-up playback . . . . . . . . . 86
Connector cover  . . . . . . . . . . . 9,91
Contact area . . . . . . . . . . . . . . . . 20
Creating black and white 

pictures. . . . . . . . . . . . . . . . . 99
Creating sepia-toned pictures . . . 99

D
DC-IN jack . . . . . . . . . . . . . . . . 9,18
DC-IN jack cover . . . . . . . . . . . 9,18
Digital zoom. . . . . . . . . . . . . . . . . 58
Direct Printing . . . . . . . . . . . . . . 128

DPOF . . . . . . . . . . . . . . . . . . . . .119
DRIVE  . . . . . . . . . . . . . . . . .68

E
EDIT . . . . . . . . . . . . . . . . . . . . . .101
Elapsed time. . . . . . . . . . . . . . . . .12
Erasing pictures . . . . . . . . . . .96
ESP metering . . . . . . . . . . . . . . . .67
Exposure compensation . . . . .77

F
FILE NAME. . . . . . . . . . . . . . . . .116
File number. . . . . . . . . . . . . . . . . .12
Fill-in flash . . . . . . . . . . . . . . . .62
Flash . . . . . . . . . . . . . . . . . . . . .9,60
Flash charge. . . . . . . . . . . . . . 11,44
Flash mode. . . . . . . . . . . . . . . 11,60
Flash mode button ( ) . . . . . 10,60
Flash off . . . . . . . . . . . . . . . . .62
Flash standby . . . . . . . . . . . . . 11,44
Fluorescent . . . . . . . . . . . . . .79
Focus Lock . . . . . . . . . . . . . . . . . .50
Format  . . . . . . . . . . . . . . . . . . . .107

G
Green lamp. . . . . . . . . . . . . . . 10,46

H
HQ  . . . . . . . . . . . . . . . . . . . . . . . .73

I
INDEX. . . . . . . . . . . . . . . . . . . . .102
Index area. . . . . . . . . . . . . . . . . . .20
Index display . . . . . . . . . . 88,89
INFO . . . . . . . . . . . . . . . . . . . . . .109

L
Landscape . . . . . . . . . . . . . . .42
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Index
Landscape + Portrait . . . . . . 42
Language . . . . . . . . . . . . . . 27
Lens. . . . . . . . . . . . . . . . . . . . . . . . 9
Lens barrier . . . . . . . . . . . . . . . . . . 9
Lithium battery pack  . . . . . . . . . . 18

M
Macro button ( ). . . . . . . . . 10,63
Macro mode  . . . . . . . . . . 11,63
Memory gauge  . . . . . . . . 11,13,44
Metering  . . . . . . . . . . . . . . . . . . . 67
Microphone . . . . . . . . . . . . . . . . . . 9
Mode Menus . . . . . . . . . . 32,33,37
Monitor  . . . . . . . . . . . . . . 10,11,44
MONITOR OFF . . . . . . . . . . . . . . 49
MONITOR ON . . . . . . . . . . . . . . . 49
Movie  . . . . . . . . . . . . . . . 43,55
MOVIE PLAYBACK . . . . . . . 92

N
Night scene . . . . . . . . . . . 43,53
NiMH batteries. . . . . . . . . . . . . . . 18
Noise reduction . . . . . . . . . . . . . . 53
NTSC. . . . . . . . . . . . . . . . . . . . . 118
Number of storable still 

pictures. . . . . . . . . . . . . . 11,74

O
OK/Menu button  . . . . . . . . . . 10,32
Optical zoom . . . . . . . . . . . . . . . . 57
Orange lamp . . . . . . . . . . . . . 10,46
Overcast . . . . . . . . . . . . . . . 79

P
PAL . . . . . . . . . . . . . . . . . . . . . . 118
PANORAMA . . . . . . . . . . . . . . . . 69
PictBridge  . . . . . . . . . . . . . . . . . 128
Picture rotation  . . . . . . . . . . . 87
PIXEL MAPPING. . . . . . . . . . . . 117

Playback button . . . . . . . . . . .84
Playback mode . . . . . . . . . . . .12,24
Playback on a TV . . . . . . . . . . . . .91
Portrait . . . . . . . . . . . . . . . . . .42
Pressing fully  . . . . . . . . . . . . . . . .45
Pressing halfway. . . . . . . . . . . . . .45
Print setting  . . . . . . . . . . . . .119
PROGRAM AUTO . . . . . . . . . .42
Protect . . . . . . . . . . . . . . . . . .95
PW ON/OFF SETUP  . . . . . . . . .113

Q
QUICK VIEW  . . . . . . . . . . . . . . . .85

R
REC VIEW . . . . . . . . . . . . . . . . .111
Rechargeable batteries. . . . . . . . .18
Record mode  . . . . . . . . . . . .73
Recording sound . . . . . . . . . . .94
Recording sound with 

movies  . . . . . . . . . . . . . . .83
Recording sound with still 

pictures . . . . . . . . . . . . . . .81
Red-eye reduction flash  . . . .61
Remaining power level . . . . . . . . .13
Remaining recording time. . . . 11,55
Resetting print reservation 

data . . . . . . . . . . . . . . . .126
Resizing . . . . . . . . . . . . . . . .100
Resolution. . . . . . . . . . . . . . . . . . .74

S
SCREEN SETUP . . . . . . . . . . . .114
Self portrait  . . . . . . . . . . . . . .43
Self-timer  . . . . . . . . . . . . . . .66
Self-timer button ( ) . . . . . . 10,66
Self-timer lamp . . . . . . . . . . . . .9,66
Sequential shooting . . . . . . .68
Setting the date and time . . .29
162



Index
Shooting mode  . . . . . . . . 11,23,41
Shooting mode button ( ). . 10,41
Shortcut Menus . . . . . . . . . . . 32,35
SHQ. . . . . . . . . . . . . . . . . . . . . . . 73
Shutter button . . . . . . . . . . . . . 9,45
Single-frame erase  . . . . . . . . 96
Single-frame playback. . . . . . . . . 84
Single-frame reservation  . . 123
Sleep mode . . . . . . . . . . . . . . . . . 24
Slideshow  . . . . . . . . . . . . . . 90
Spot metering  . . . . . . . . . . . 67
SQ . . . . . . . . . . . . . . . . . . . . . . . . 73
Startup/Shutdown screen  . . . . . . 26
Strap . . . . . . . . . . . . . . . . . . . . . . 15
Strap eyelet . . . . . . . . . . . . . . . 9,15
Sunlight . . . . . . . . . . . . . . . . 79
Super macro mode . . . . . . . 65

T
Top menu  . . . . . . . . . . . . . . . . . . 33
Total recording time. . . . . . . . 12,74
Tripod socket. . . . . . . . . . . . . . . . 10
Tungsten  . . . . . . . . . . . . . . . 79
Two-in-one pictures . . . . 71

U
USB connector  . . . . . . . . . . . 9,129

V
VIDEO OUT. . . . . . . . . . . . . . . . 118
Viewfinder . . . . . . . . . . . . . . . 10,46
Virtual dial . . . . . . . . . . . . . . . . . . 41

W
White balance . . . . . . . . . . 79

X
xD-Picture Card. . . . . . . . . . . . . . 20

Z
Zoom lever . . . . . . . . . . 9,57,86,88
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How to use your PC to get the 
most from images taken with 

your digital camera.

z Thank you for purchasing an Olympus digital camera.
z This manual provides instructions on how to install the USB 

driver. To ensure correct installation, refer only to these 
installation procedures. 

DIGITAL 
CAMERA

PERSONAL 
COMPUTER

DIGITAL CAMERA — PC CONNECTION
OPERATION MANUAL



Introduction

This manual explains in detail how to connect your Olympus digital camera to 
a computer. Read it carefully and keep it in a safe place for future reference.

About this manual
z The information contained in this manual may be subject to change without 

notice. For the latest information on the product, please consult your local 
Olympus representative.

z The information contained in this manual has been compiled by taking all 
possible measures to ensure its accuracy. However, if you find any errors or 
incomplete information, please contact your local Olympus representative.

z It is prohibited by copyright laws to duplicate in part or in whole the information 
contained in this manual, except for personal use. Reproduction without 
permission of the copyright owner is prohibited.

z The PC screens shown in this manual may differ slightly from the actual displays 
on some PC models.

Trademarks
z Microsoft and Windows are registered trademarks of Microsoft Corporation.
z Macintosh is a trademark of Apple Computer Inc.
z All other company and product names are registered trademarks and/or 

trademarks of their respective owners.
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Flowchart

By connecting the camera to a computer with the provided USB cable, 
images on a card can be transferred to the computer. Some OS’s (operating 
systems) may need a special setup before connecting to the camera for the 
first time. Follow the chart below.
For details, see the Olympus Corporate Site or phone customer 
support.

* Even if your computer has a USB connector, data transfer may not function 
correctly if you are using one of the operating systems listed below or if you have 
an add-on USB connector (extension card, etc.).

z Windows 95/NT 4.0
z Windows 98/98 SE upgrade from Windows 95
z Mac OS 8.6 or lower (except Mac OS 8.6 equipped with USB MASS Storage 

Support 1.3.5 installed at the factory)
z Data transfer is not guaranteed on a home-built PC system or PCs with no 

factory installed OS.

Identifying the OS (p.6)

Windows 98/
98 SE (Second Edition) Windows Me/2000/XP MacOS 9.0 - 9.2/OS X

* For OS 8.6, see below.

Installing the USB 
driver for Windows 
98 (p.9)

Connecting the camera to the computer using the provided USB cable
(Windows p.11,  Mac p.24)

Confirming the computer recognizes 
the camera (p.14)

Downloading image files
(Windows p.17,  Mac p.26)

Disconnecting the USB cable
(Windows p.20,  Mac p.30)
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Flowchart
• When connecting the camera to the computer, make sure that there is 
sufficient remaining battery power. When connected (transmitting) to the 
computer, the camera does not enter the sleep mode nor will the camera’s 
power turn off automatically. Depending on the camera model, when the 
battery power runs out or the internal temperature rises, the camera may 
stop operating automatically. This could cause the computer to 
malfunction, and any image data (file) being transmitted may be lost. Be 
careful when downloading files for a long period of time. Use the AC 
adapter (optional) when downloading files.

• If you connect or disconnect the AC adapter when the camera is connected 
to the computer and is running on battery power, it may result in the loss of 
image data on the card or cause a malfunction in the computer. Before 
connecting or disconnecting the AC adapter, disconnect the camera from 
the computer and make sure that the camera is turned off.

• To avoid computer malfunctions, do not turn off the camera when the 
camera is connected to a computer.

• If the camera is connected to the computer via a USB hub, operation may 
not be stable if there are any compatibility problems between the computer 
and the hub. In such cases, do not use the hub and connect the camera 
directly to the computer.

• You can view images using: graphics applications that support the JPEG 
file format (Paint Shop Pro, Photoshop, etc.); Internet browsers (Netscape 
Communicator, Microsoft Internet Explorer, etc.); CAMEDIA Master 
software; or other software. For details on using commercial graphics 
applications, refer to their instruction manuals.

• QuickTime is needed for playing back movies. QuickTime is included on 
the provided software CD.

• If you want to process images, make sure to download them to your 
computer first. Depending on the software, image files may be destroyed if 
the images are processed (rotated, etc.) while they are on the card.
5



Identifying the OS

Identify the OS on your computer before connecting the camera. How to 
identify the OS depends on the computer.

z Windows

1 Double-click the “My Computer” 
icon on your desktop.
When the “My computer” icon is not on 
your desktop, click “Control Panel” 
from the  “Start” menu.

2 Double-click the 
“Control Panel” icon.

3 Double-click the 
“System” icon.

The way the file icons inside the folder appear may vary depending on your 
version of Windows. If you don’t see the icon you are looking for, click on 
“view all Control Panel options” on the left of the window.
6



Identifying the OS
4 A System Properties window will 
appear. Note and record the 
“System:” information.
Confirm that your system is Windows 
98, 98 SE, Me, 2000 Professional or 
Windows XP, then press “OK” to close 
the window. 

If your OS is Windows 98/98 SE, proceed to “Installing the USB 
driver for Windows 98” (  p.9).
Users running Windows Me/2000/XP  p.11
Users running other OS  p.31

z Mac OS (Macintosh)

Select “About This Computer” from the Apple menu on the menu bar. 
A window appears with the name of the computer’s OS.
Confirm that the OS is OS 9.0-9.2 or OS X.

Users running Mac OS 9/X  p.23
Users running other OS  p.31
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Windows

Using Windows 98/Me/2000/XP

zYour computer is turned on and Windows is running. 
zIf you are running any applications, quit them all.
zYou are recommended to power the camera using the optional AC adapter. 

If the battery power runs out while the computer is accessing the card in the 
camera, the camera will turn off in the middle of the operation and this could 
destroy image files (data). If you are using batteries, make sure that there 
is sufficient remaining battery power.

Installing the USB driver for Windows 98 (When using Windows 
98/98 SE) ....................................................................................... 9
Connecting the camera to the computer ................................. 11
Confirming the computer recognizes the camera .................. 14
Confirming the USB driver is installed .................................... 15
Downloading images to your computer................................... 17
Disconnecting the camera from your computer ..................... 20

Make sure that:
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Installing the USB driver for Windows 98
(When using Windows 98/98 SE)

If your OS is Windows 98/98 SE, you must install the USB driver. Follow the 
instructions below to install the USB driver in your computer. Once it is fully 
installed, you do not need to repeat the procedure again. 
If your OS is Windows Me/2000/XP, you do not need to install the USB 
driver. Proceed to “Connecting the camera to the computer” (  p.11).

1 Insert the provided software CD 
into your CD-ROM drive.

2 The Olympus Windows Installer 
should automatically launch. Click 
“USB Driver”.
If the USB driver is already installed in 
your computer, this option will not 
appear. 
• This option will not appear if you are 

using Windows Me/2000/XP.

If the installer is not automatically launched, select “Run..” on the 
“Start” menu and then execute “(drive letter):/ Information.exe”.

The drive letter of the CD-ROM varies depending on the computer.
To identify the drive letter, double-click “My Computer” on the desktop.
9



Installing the USB driver for Windows 98 (When using Windows 98/98 SE)
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3 Click “Continue”. The installation of 
the USB driver will start.

4 Click “OK” to restart your computer 
and the installation is complete.

5 When the computer has restarted, installation is complete. If the 
Olympus Windows Installer screen appears, click “Close” and 
remove the CD-ROM from the CD-ROM drive.
0



W
indow

s
Connecting the camera to the computer

Users running Windows 98/98SE need to install the USB drive before 
connecting the camera to your computer for the first time. (  p.9)

1 Some camera models have 
a “USB” setting in the 
menu. Make sure that “PC” 
is selected before 
connecting. This is not 
required if your camera 
does not have this setting. 
For details on how to 
operate the menu, refer to your camera's reference manual.

2 Insert the marked end of the provided USB cable into the USB 
port on your computer as shown below. 

3 After making sure that the camera is turned off, connect the end 
of the USB cable to the USB connector on the camera.
The location of the USB connector or multi connector varies depending 
on the camera model. Refer to the camera manual for details.

The location of the USB port varies depending on the computer. For details, 
refer to your computer's manual. 
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[SETUP] tab
Menu button

Arrow pad

Look for this mark.

USB port

Terminal

USB port

Computer

USB connector or 
multi connector

USB cable

Smaller terminalRectangular terminal
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Connecting the camera to the computer
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4 Turn the camera on.
Camera with a lens barrier
The power turns on automatically, 
with the exception of some models 
which require you to press the  
(monitor) button.
When the camera is turned on, the 
lamp on the right of the viewfinder 
lights up.

Camera with a  mode
Set the mode dial to . 
(If the camera has a power 
switch as well as a mode 
dial, turn the power switch to 
ON.)

5 Some camera models 
display this screen (shown 
right) on the monitor. When 
this screen appears, use the 
arrow pad to select “PC” and 
press the OK button.

6 The computer recognizes the camera as a new device.
When you connect the camera to the computer for the first time, the 
computer automatically recognizes the camera. Click “OK” when the 
message saying that the installation is completed appears. The 
computer recognizes the camera as a “Removable Disk”.

Lens barrier

Lamp

(monitor) button

Power switch

Mode dial

GOSELECt

Arrow pad

OK button
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Windows XP
You can download image files from the camera easily.
Select “Copy pictures to folder on my computer using Microsoft 
Scanner and Camera Wizard”, then follow the on-screen instructions. 
You may also select “take no action” to bypass the Microsoft Scanner 
and Camera Wizard. You may then use a more advanced image 
viewing/editing program such as Olympus CAMEDIA Master 
software. For detailed instructions on downloading, refer to the 
CAMEDIA Master software user’s guide.

When the camera is connected to the computer, none of the camera buttons 
are functional.
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Confirming the computer recognizes the camera

1 Double-click the “My Computer” 
icon on the desktop.
For users running Windows XP, click 
“My Computer” from the “Start” menu.

2 Make sure the “Removable Disk” 
icon appears in the window.
There may already be other 
“Removable Disk” icons for other 
devices, such as a removable media 
drive or USB SmartMedia Reader/
Writer. In this case, the digital camera 
is recognized as another “Removable 
Disk”.
If you cannot find the icon, the camera 
and computer are not connected 
properly. Turn the camera off, 
disconnect the camera from the 
computer and connect again, or proceed to “Confirming the USB driver 
is installed” (  p.15) to make sure that the USB driver is fully 
installed.
4
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Confirming the USB driver is installed

If the computer does not recognize the camera as a Removable Disk, follow 
the procedure below to check whether the USB driver has been fully installed.

1 Open “My Computer” 
and double-click the 
“Control Panel” icon.
For users running 
Windows XP, open 
“Control Panel” from the 
“Start” menu.

2 Double-click the 
“System” icon.

3 The System window will appear. 
Click the “Device Manager” tab.
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Confirming the USB driver is installed
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4 Confirm that “OLYMPUS Digital 
Camera” is in the “Universal Serial 
Bus Controller” category.
If you cannot find the “OLYMPUS 
Digital Camera”, turn the camera off, 
disconnect the camera from the 
computer and start again.
Users running Windows 98/98 SE 
start again from “Confirming the USB 
driver is installed”, and Users running 
Window Me/2000/XP start from 
“Connecting the camera to the 
computer”.

If the USB driver was successfully installed, you can find the following in the 
“Device Manager”.

– the name of the camera you have connected listed under “Disk drives”
– “OLYMPUS Digital Camera” listed as one of the items in the “Universal 

Serial Bus Controller” category
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Downloading images to your computer

1 Double-click the “My Computer” 
icon on the desktop.
For users running Windows XP, click 
“Control Panel” from the “Start” menu.

2 Double-click the “Removable Disk” 
icon.
A new “Removable Disk” icon appears 
when the camera is connected to the 
computer, as the digital camera is 
recognized as a “Removable Disk”.

3 Double-click the 
“Dcim” folder.

If an error message appears when you double-click the icon, there may be a 
problem with one of the following:
c the camera’s power source (the AC adapter is not properly connected or 

the battery power is low)
Make sure that the AC adapter is correctly connected or that the batteries 
are not running low.

d the card (there is no card in the camera or there is a problem with the 
card)
Check that you can play back pictures stored on the card on the monitor 
of your digital camera.
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4 Double-click the “100olymp” folder.
Image files (JPEG files) with files 
names such as “P1010001.jpg” are 
displayed.

5 Double-click the “My Documents” 
icon on the desktop.
If you cannot find the icon on the 
desktop, select “Explorer” on the Start 
menu and double-click the “My 
Documents” icon.

• The camera automatically assigns folder names and file names according 
to the following rules.

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned 

the next number.
• Months January through September are expressed by the numbers 1 

through 9, October by the letter A, November by B and December by C.

Folder name
(Example)

File name
(Example)

Serial number Month / Day / Serial number
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Downloading images to your computer
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The “My Documents” window is 
displayed.

6 Drag & drop the image 
you want to save in the 
computer (in this case, 
P1010012.jpg)  to the 
“My Documents” 
window.
The image is saved in the 
computer (in My 
Documents folder).
• To select all files, choose Edit > Select all.

When the image file has been downloaded to the computer, you can view 
images by double-clicking the image files downloaded to your computer. The 
files will be opened in the default image viewer of the operating system. If you 
want to view the image a different size or process it, you will need to open the 
image with software that supports JPEG or TIFF images files, such as Paint 
Shop Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while 
the image is being copied. Never open the card cover on the camera, load or 
remove the batteries, or connect or disconnect the AC adapter while the lamp 
is blinking as the image files may be destroyed.
19



2

W
in

do
w

s
Disconnecting the camera from your computer

If your OS is Windows Me/2000, proceed to “Windows Me/2000/XP” (  
p.21).

z Windows 98

1 Make sure that the lamp on the 
right of the viewfinder or the card 
access lamp is not blinking.
Some camera models have either a 
lamp on the right of the viewfinder or 
a card access lamp, and the location 
varies depending on the model. 
Refer to your camera’s reference 
manual.

2 Double-click the “My Computer” 
icon and right-click the “Removable 
Disk” to display the menu.

3 Click “Eject” on the menu.

Lamp

Card access lamp
0



Disconnecting the camera from your computer
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4 Make sure that the lamp on the right 
of the viewfinder or the card access 
lamp is not blinking.
The green lamp lights on some 
models. If the lamp is no flashing, then 
the cable can be removed.

5 Remove the USB cable from the 
camera.

6 Remove the USB cable from your computer.

z Windows Me/2000/XP

1 Make sure that the lamp on the right 
of the viewfinder or the card access 
lamp is not blinking.
Some camera models have either a 
lamp on the right of the viewfinder or a 
card access lamp, and the location 
varies depending on the model. Refer 
to your camera's reference manual.

Lamp

Lamp
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Disconnecting the camera from your computer
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2 Click the   “Unplug or Eject 
Hardware” icon on the task bar.
The message saying that the drive 
has been stopped appears.

3 Click on the message.
The “Unplug or Eject Hardware” 
window appears.

4 When a message appears, click 
“OK”.

5 Remove the USB cable from the 
camera.

6 Remove the USB cable from your computer.

If the window returns the following message when you click “Unplug or Eject 
Hardware”, first make sure that no image data is being downloaded from the 
camera, and then remove the USB cable.
2
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Using Mac OS (9/X)

zYour computer is turned on and Mac OS is running.
zIf you are running any applications, quit them all.
zYou are recommended to power the camera using the optional AC adapter. 

If the battery power runs out while the computer is accessing the card in the 
camera, the camera will turn off in the middle of the operation and this could 
destroy image files (data). If you are using batteries, make sure that there 
is sufficient remaining battery power.

If you are running Mac OS X, the connection to the computer and 
downloading the image data are verified. Restrictions such as the 
following may occur due to the OS.
zThe image file properties are not displayed correctly.
zImages in the camera cannot be opened without first downloading 

them. etc.
For more details, visit the Olympus web site.

Connecting the camera to the computer ................................. 24
Downloading images to your computer................................... 26
Disconnecting the camera from your computer ..................... 30

Make sure that:
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Connecting the camera to the computer

1 Some camera models have 
a “USB” setting in the 
menu. Make sure that “PC” 
is selected before 
connecting. This is not 
required if your camera 
does not have this setting. 
For details on how to 
operate the menu, refer to your camera's reference manual.

2 Insert the marked end of the USB cable into the USB port on your 
computer as shown below. 

3 After making sure that the camera is turned off, connect the end 
of the USB cable to the USB connector on the camera.
The location of the USB connector or multi connector varies depending 
on the camera model. Refer to the camera manual for details.

The location of the USB port varies depending on the computer. For details, 
refer to your computer's manual.
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[SETUP] tab
Menu button

Arrow pad

Look for this mark.

Terminal

USB port

USB port

Computer

USB connector or 
multi connector

USB cable
Smaller terminal

Rectangular terminal
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Connecting the camera to the computer
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4 Turn the camera on.
Camera with a lens barrier
The power turns on automatically, 
with the exception of some models 
which require you to press the  
(monitor) button.
When the camera is turned on, the 
green lamp on the right of the 
viewfinder lights up.

Camera with a  mode
Set the mode dial to . 
(If the camera has a power 
switch as well as a mode dial, 
turn the power switch to ON.)

5 Some camera models 
display this screen (shown 
right) on the monitor. When 
this screen appears, use the 
arrow pad to select “PC” and 
press the OK button.

6 The computer recognizes the 
camera as a new device.
The computer recognizes the camera 
automatically and an “Untitled” icon 
appears on the desktop.
If you cannot find this icon, turn off the camera and connect again.

Mac OS X
When the computer has recognized the camera, the Apple Image 
Capture software automatically launches.  p.29

When the camera is connected to the computer, none of the camera buttons 
are functional.

Lens barrier

Lamp

(monitor) button

Mode dial

Power switch

GOSELECt

Arrow pad

OK button
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Downloading images to your computer

z Mac OS 9

You can download images from the camera and save them in your computer 
(in this case, in the Hard Disk).

1 Double-click the “Untitled” icon 
displayed on the desktop when the 
camera is connected to the 
computer.

2 Double-click the 
“Dcim” folder.

3 Double-click the 
“100OLYMP” folder.

If you cannot find this icon, or if an error message appears when you double-
click the icon, there may be a problem with one of the following:
c the camera’s power source (the AC adapter is not properly connected or 

the battery power is low)
d the card (there is no card in the camera or there is a problem with the 

card)
Check that you can play back pictures on the monitor of your camera.

e the USB cable (the camera is not properly connected to the computer by 
the USB cable).

f Apple “File Exchange” extension is not enabled.
• Please refer to your Apple operating system manual for instructions on 

how to enable this extension.
6



Downloading images to your computer
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Image files (JPEG files) with files 
names such as “P1010001.JPG” are 
displayed.

4 Double-click the “Macintosh HD” 
icon on the desktop.

• The camera automatically assigns folder names and file names according 
to the following rules.

• Serial numbers of image files run from 0001 to 9999.
• Serial numbers of folders run from 100 to 999.
• When file number 9999 is reached, a new folder is created and assigned 

the next number.
• Months January through September are expressed by the numbers 1 

through 9, October by the letter A, November by B and December by C.

Folder name
(Example)

File name
(Example)

Serial number Month / Day / Serial number
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Downloading images to your computer
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The “Hard Disk” window is displayed.

5 Drag & drop the image 
you want to save in the 
computer (in this case, 
P1010012.JPG) to the 
“Hard Disk” window.
The image is saved in 
the computer (in the 
Hard disk).
• To select all images,  

click Edit > Select all.

When the image file has been copied to the computer, you can view images 
by double-clicking the image files in the “Hard Disk” folder. The files will be 
opened in the default image viewer of the operating system. If you want to 
view the image a different size or process it, you will need to open the image 
with software that supports JPEG or TIFF images files, such as Paint Shop 
Pro, Photoshop or CAMEDIA Master software.

The lamp on the right of the viewfinder or the card access lamp blinks while 
the image is being copied. Never open the card cover on the camera, load or 
remove the batteries, or connect or disconnect the AC adapter while the lamp 
is blinking as the image files may be destroyed.
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Downloading images to your computer
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z Mac OS X

Malfunctions such as the following may occur due to the OS.
• If the camera is not connected correctly, a malfunction occurs in the 

computer.
• Date and time information of image files is not accurately displayed.
• If the card cover of the camera is opened while connecting to the computer, 

the “untitled” icon does not disappear from the desktop. etc.

When the computer has recognized the camera, the Apple Image Capture 
software dialog appears.

1 From the “Download To” menu, 
select a destination folder. 

2 To download all images, click 
“Download All”.
To selectively download images, 
click “Download Some” and 
highlight the desired images.
The images are transferred from the camera to your computer. 

If you are operating Mac OS X and you want to download images using the 
same procedure as for Mac OS 9, select “File > Close” and exit the Apple 
Image Capture software. At this time, the camera is indicated as “unlabeled”. 

If you use the Apple Image Capture software, images downloaded to your 
computer and transferred back to a card may not play back on the camera or 
may have other problems.
29
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Disconnecting the camera from your computer

1 Make sure that the lamp on the 
right of the viewfinder or the card 
access lamp is not blinking.

2 Drag the “untitled” icon on the 
desktop to “Trash”.

3 Make sure that the lamp on the right 
of the viewfinder or the card access 
lamp is not blinking.
The green lamp lights on some 
models. If the lamp is no flashing, then 
the cable can be removed.

4 Remove the USB cable from the 
camera.

5 Remove the USB cable from your 
computer.

Lamp

Card access lamp

Lamp
0



Downloading image files using other OS
(For other OS users)

Users running other OS cannot connect the camera directly to a computer.
 z Windows 95    z Windows NT    z Mac OS before OS 9
For an OS listed above, you can download images directly to your computer 
using an optional floppy disk adapter or PC card adapter.
For details, see the Olympus Corporate Site or phone customer support.

Does your computer have a USB interface?
Is there a port marked  on your computer?

Does your computer have a built-in PC card slot?

Consult your nearest Olympus representative. 

Is your OS one of 
the following?
•Windows 98
•Windows 2000
•Windows Me
•Windows XP
•Mac OS 9/X

YesNo

No

Yes

Connect the camera directly 
to your computer using the 
provided USB cable.

Use the optional USB 
reader/writer.*
*Certain card readers may not be 
compatible with Mac OS X.

Check the Olympus website for 
the most up-to-date compatibility 
information.

Use the optional PC card adapter*.

*Not supported by Windows NT4.0 or 
lower

No

Yes
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